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Chapter 1: Introduction to 
LabScribe and the ETH-256

Overview
A brief explanation of the ETH-256NI controls are presented 

below. For more a detailed explanation and troubleshooting assis-
tance, consult the hardware appendix at the end of this manual.

Front Panels 
and Controls

The ETH-256 is divided into two identical functional units (Figure 
1-1 on page 1) both are able to make low-noise, AC-coupled 
recordings of bioelectric potentials or DC-coupled transducer 
recordings. Four knobs control each channel. Their functions are 
described below.

 Figure 1-1: A diagram of the front (upper) and rear (lower) 
of ETH-256
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High Pass (Hz) The High Pass (Hz) switch is used to select the function of the 
channel. It has four positions. The DC position DC couples the input 
for measurement from transducers or other sensors such as pH 
electrodes or Ion Selective Electrodes (ISEs). There are three high 
pass filter settings: 0.03 for ECG, 0.3 for ECG or EEG and 3.0 for 
EMG.   The higher the value of the AC coupling filter, the more signal 
contributions from body movement or breathing are removed.

Offset In any high pass position, the offset knob can be used to move the 
displayed signal up or down on the computer screen

Gain Gain allows small signals to be made larger before going to the 
recording unit.

Low Pass (Hz) The low pass control is used to adjust the amount of noise seen on 
the baseline of your recording. In general, the lower the filter value, 
the quieter the trace will appear, and the less able it will be to view 
rapidly changing events.

Rear Panel and 
Connectors

All of the input and output connectors for the ETH-256 are located 
on the rear panel (Figure 1-1 on page 1).

Input Use this connector to connect the transducer or biopotential pod.

Output The output BNC connector contains the output signal. It must be 
connected to your recorder for the signal to be visible on the 
computer screen

The LabScribe software traditionally resides in a folder in the 
Program Files folder on the computer s hard drive. The software 
permits electrical signals to be displayed on the computer screen in a 
format that resembles a laboratory strip chart recorder. Each 
peripheral device may produce signals of a different size and 
duration. Therefore, you need to be able to make adjustments to the 
software so that the signals are the appropriate size and shape on 
the screen. In the tutorial that follows you will learn how to make 
these adjustments and how to make simple measurements from 
traces. 

In future experiments you will open the software and find that many 
recording parameters have been set for you. This will permit you to 
collect data quickly and efficiently, making only minor adjustments to 
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obtain the best response. Over time you may forget how to perform 
certain tasks. You can refresh your memory by referring to this 
tutorial or to the User s Manual, which describes additional features 
of the unit and software that are not covered here.

Experiment 1: This is LabScribe“ - A Tutorial
LabScribe allows data to be accumulated, displayed and analyzed 

on a computer screen in a format similar to a laboratory strip chart 
recorder.   

Equipment 
Setup Connect the ETH-256 and the computer:

1 Place the ETH-256 unit on the bench, close to the computer. 

2 Use the shielded cable with the four-input breakout box provided and 
connect it to the National Instruments Analog to Digital converter card (NI-
A/D card) in your computer. The NI-A/D card must be properly installed 
and have a NIDAQ assigned device number.

3 Connect the output of channels one and two on the rear panel of the ETH-
256 to the input BNC s labeled Ch1 and Ch 2 on the provided breakout 
box. 

4 Insert the power plug into the rear of the ETH-256 unit and the trans-
former into the electrical outlet.   Confirm that the red power LED is illumi-
nated.

Start the 
Software

1 Click the (Windows) Start menu, move the cursor to Programs and then to 
the iWorx folder and select LabScribe. 

2 When the program opens, select Load from the Settings menu.   

3 When the dialog box appears select NI Animal  and then click OK.

4 Click on the Settings menu again and select the Tutorial settings file.

5 After a short time, LabScribe will appear on the computer screen with the 
Tutorials settings (Figure 1-2 on page 4).
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The LabScribe software has five windows:

¥ Main record incoming signals and perform data analysis.

¥ Analysis perform data analysis.

¥ Journal type and insert recordings to construct a lab report.

¥ Marks review typed annotations entered during data accumulation.

¥ Preview examine incoming signals without recording.

The Main window is displayed when the application is first opened. 
Notice that each of the channels has its own (white) recording area, 
with a title area (above) containing a title, AutoScale and FullScale 
select buttons, and the voltage value. Above the channel one title 
area is a time value, the sampling speed, the display time, the mark 
comments, and the Start  button.

 Figure 1-2: The LabScribe Window
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Recording with 
LabScribe

The Signal The output from a plethysmograph will be used as a signal source.

Proceed as follows:

1 Locate the DIN 8 plug on one end of the plethysmograph cable; insert it 
carefully into the DIN input on channel one (Figure 1-3 on page 5). 

2 Locate the plethysmograph on the other end of the cable. Place the unit 
on the volar surface (where the fingerprints are located) of the distal 
segment of a middle finger; wrap the Velcro to attach the unit firmly to the 
end of the finger.

 Figure 1-3: The connection between the plethysmograph 
and the ETH-256 

3 Set the controls on the ETH-256 (Figure 1-1 on page 1) as follows

Ch. 1: Plethysmograph Ch. 2: No Device

Gain X10 x1

High Pass DC DC

Low Pass 50Hz 50Hz

Recording with 
LabScribe The size of the signal:

1 Click Start (Figure 1-2 on page 4) and record the finger pulse.

2 Click AutoScale in the channel one title area and see the rhythmic signal 
get bigger. Possible problem: If the NI card and computer are not commu-
nicating there will be a sine wave in all four recording windows. If this 
happens, stop recording and select Preferences under the Edit menu. 
Confirm that the NI card option is selected and that the proper device 
number has been entered.
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3 Click Stop to halt recording. Click and drag the red arrow (in the right 
margin of the window) up and down to make the channel one recording 
window as large or small as desired.

The screen time:

The default value for the time for a signal to cross the screen is 10 
seconds  this value is displayed as Display Time in the area above 
the channel one title line (Figure 1-2 on page 4). The screen time can 
be changed by clicking the display controls in the toolbar (Figure 1-4 
on page 6). 

 Figure 1-4: The display icons in the tool bar. 

Demonstrate this as follows:

1 Click the left icon (big mountain) and notice that the trace spreads out
the Display Time is 5 seconds.

2 Click the right icon (small mountains) twice and see that the rhythmic 
peaks get closer the Display Time is 20 seconds.

3 Click the left icon once to return to a Display Time of 10 seconds.
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The sampling rate:

The default value for the number of samples taken per second is 
200 this value is displayed as speed in the top left margin above the 
channel recording windows. While this value is acceptable for most 
experiments, it can be changed by selecting Preferences in the Edit 
menu and adjusting the sampling rate. Such a change does not 
change the screen time.

Saving a 
LabScribe File

It is wise to save work in any computer application, and LabScribe 
is no exception:

1 Click on the File menu and select Save As.

2 When the standard panel appears, type a meaningful name. Click Save to 
save the file(.iwd) to a known destination (e.g. the Desktop) on the 
computer.

Making Marks 
on a Record

Many experiments are divided into a series of exercises. It is 
convenient to annotate each exercise, so that during subsequent 
review of your data file it is possible to determine what was done at 
any particular stage.   This will be done by typing (the comment 
appears in the Marks area next to Start, see Figure 1-2 on page 4) on 
the keyboard and pressing the Enter key.

Marks can be entered in two ways:

Entering Marks when not recording Notice that when data have 
been recorded, two blue vertical lines or cursors overlay the screen. 
As you will discover later, these can be used to make measurements. 
However, if you type a comment on the keyboard and press the Enter 
key, the mark will be entered in the lower margin at the left cursor.

Entering Marks while recording Marks can be entered on-the-fly 
when data are being recorded:

1 Click Start.

2 Type my first comment  on the keyboard and notice that the words 
appear in the Marks area to the left of Start.

3 Press the Enter key on the keyboard and notice that

¥ the words disappear

¥ a vertical line appears in the LabScribe window.

4 Type my next comment  repeat step #3.
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5 Repeat to enter a total of five different comments, pressing Enter after 
each.

6 Click Stop.

7 Select Save in the File menu to update your file.

The last mark may be seen in the lower margin of the recording 
window.

Data Analysis 
of your 
LabScribe File

While data analysis may be performed during the lab session, your 
file can be stored on a floppy disk or on a hard drive. The file can be 
opened using a compatible version of the LabScribe software; the 
National Card is not required for data analysis.

Data analysis can be done in the Main or the Analysis window. 
Access to these windows can be gained either through the Windows 
menu or by clicking on the appropriate icon (Figure 1-5 on page 8).

 Figure 1-5: The Windows icons in the toolbar.

Data Analysis in 
the Main 
Window

Navigating the 
Main Window

There are two ways to navigate around a data file in the Main 
window, the Marks option and the scroll bar.

Scrolling

1 Move the cursor to the scroll bar in the lower margin.

2 Click the arrows to scroll the screen to the left or right; notice the typed 
marks in the lower right margin.
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Marks

1 Click in the Windows menu and select Marks, or click in the Marks icon in 
the toolbar (Figure 1-5 on page 8). Either procedure will display a panel 
with the typed comments, which may be modified at this stage.

2 Click on the time and then GoTo.

3 The panel will disappear and the relevant portion of data will be displayed 
in the center of the recording window.

Notice Marks can be moved vertically and placed anywhere in the 
recording by clicking and dragging the mouse. Marks in a given view 
can be reset by electing Reset Marks under the View menu.

Making 
Measurements 
in the 
LabScribe 
Window

Measurements are taken using the cursors, which are vertical lines 
that address all channels and can be called using one of the cursor 
icons (Figure 1-6 on page 9). 

 Figure 1-6: The cursor icons in the tool bar.

Using a Single 
Cursor

1 Click the right cursor icon, with a single vertical bar a (blue) vertical line 
appears over the recording window with a star where the bar intersects 
each trace.

2 Click and drag the line to the left or right to make measurements of:

¥ the absolute time from the beginning of the trace shown in the 
top left margin, above the channel one title area.

¥ the absolute voltage displayed in the voltage value area on the 
right of the channel title area.

Using Two 
Cursors

1 Click the left cursor icon, with two vertical bars two (blue) vertical lines 
appear over the recording window, one with a star and the other with a 
square where the bar intersects the trace (Figure 1-7 on page 10).
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2 Click and drag either or both lines to the left or right to display the 
difference in:

¥ time shown in the top left margin, above channel one.

¥ the voltage displayed in the value area on the right, above each 
channel recording window.

 Figure 1-7: A finger pulse recorded in the Main window.

The Journal The Journal can be used as a notebook and as a means to 
construct a lab report. It is possible to copy (Edit menu) a screen of 
data, open the Journal (Windows menu or click the icon (Figure 1-5)), 
and Paste (Edit menu).   Return to the Main window either through 
the Windows menu or by clicking on the Main icon.

Data Analysis in 
the Analysis 
Window

Additional data analysis features are available through the Analysis 
window (Figure 1-8 on page 11), which will open only when a region 
of data in the Main window has been selected using two cursors 
(Figure 1-6 on page 9). The data displayed are the sample points 
between the two cursors.
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 Figure 1-8: A finger pulse recorded in the Analysis window.

1 Click the left cursor icon, with two vertical bars (Figure 1-6 on page 9)
two blue vertical lines appear over the recording window.

2 Drag the cursors left and right until a region of interest is located between 
the two blue lines.

3 Open the Analysis window by either:

¥ selecting Analysis from the Windows menu.

¥ clicking the Analysis icon (Figure 1-5 on page 8).

Channel Display All available channels are displayed under one another. To change 
this:

¥ click to de-select 1, 2 or 3 channels from the display channels list at the 
left.

¥ click to stack or superimpose the remaining channels in the Analysis 
window.

1 Find the list of channels displayed.

2 Click to de-select all but channel one the one with your finger pulse. 

Screen Display The Display time can be changed in increments of two as in the 
Main window (Figure 1-2 on page 4) and the trace can be scrolled 
horizontally in the Analysis window using the arrows in the lower 
margin.
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Data Values The cursors can be moved horizontally by clicking and dragging to 
the left or right. Data values for any one channel are displayed in the 
upper margin of the Analysis window. The channel analyzed can be 
changed by clicking the appropriate selection in the pop-down menu 
in the upper left margin, and the accuracy of the values (number of 
decimal places) can be set by changing the Precision setting. 

The upper margin displays values for voltage and time for each 
cursor, their difference, and the maximum, minimum and mean 
values. The titles or data can be copied into the Journal by right 
clicking the mouse in the data display area of the analysis window 
and selecting the Add Data/Titles to Journal item.

1 Move the cursor so that the symbol on each is located on adjacent peaks 
of your finger pulse record.

2 Read off the time difference (t2 - t1) between the two cursors.

3 What is your heart rate (60/(t2 - t1))?

4 Right mouse click in the Analysis window and select:

 ¥ add titles to Journal.

 ¥ add data to Journal.

5 Select Copy (Edit menu), open the Journal (Windows menu or click the 
icon (Figure 1-5 on page 8)), and Paste (Edit menu).   

6 Return to the main window

As in the Main window, the record can be copied and pasted 
directly into the Journal, displaying the Marks and the trace with only 
a portion of the horizontal axis.

Channel Features Raw data can be displayed on all channels, and data manipulations 
like setting units and inverting the trace can be achieved by a right 
mouse click before or after recording. In addition, a right mouse click 
on the recording window of channels two, three or four displays 
either a rate or an integral of the data in channels one, two and 
three, respectively. This can be demonstrated by integrating the 
finger pulse signal to display the blood flow through the finger:

1 Place the cursor over channel two, right click the mouse and select 
Integrate.

2 Click the left cursor icon, with two vertical bars (Figure 1-6 on page 9)
two blue vertical lines appear over the recording window.
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3 Drag the cursors left and right until a region of interest is located between 
the two blue lines.

4 Open the Analysis window by either:

¥ selecting Analysis from the Windows menu.

¥ clicking the Analysis icon (Figure 1-5 on page 8).

5 Your data may look like Figure 1-9 on page 13.

 Figure 1-9: Finger pulse (upper trace) and its integral 
(lower trace) in the Analysis windows.
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Chapter 2: Cardiovascular 
Physiology

Overview
The heart is a pump that pushes blood around the body. Blood 

enters the heart at a low pressure and leaves at a higher pressure; it 
is this high arterial pressure that provides the energy to force blood 
through the circulatory system. Figure 2-1 on page 15 shows the 
organization of the human heart and the circulatory system. Blood 
returning from the body is sent to the right side of the heart and then 
to the lungs to pick up oxygen and release carbon dioxide. This 
oxygenated blood is then sent to the left side of the heart and back 
to the body, where oxygen is liberated and carbon dioxide is 
collected. The complete division of the heart insures that there is no 
mixing of deoxygenated blood (in the right side) with oxygenated 
blood (in the left side). 

 Figure 2-1: A diagram to show the circulation of blood 
around the human body and its association with the heart, 
composed of a right atrium (RA), a left atrium (LA), a right 
ventricle (RV), and a left ventricle (LV).

The mammalian heart is autorhythmic, since it will continue to beat 
if removed from the body (and kept in an appropriate solution). 
Heart contractions are, therefore, not dependent upon the brain, 
rather the rhythm comes from within the heart itself. The heart is 
composed almost entirely of large, strong muscle fibers, which are 
responsible for the pumping action of the heart. Other cardiac 
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muscle cells are weakly contractile and produce the rhythm for, and 
conduct it to, the rest of the heart. A group of these weak muscle 
cells is located in the sinoatrial (SA) node (Figure 2-2 on page 16) 
and acts as the pacemaker for the heart. These cells rhythmically 
produce action potentials which spread via gap junctions to fibers of 
both atria. The resulting contraction pushes blood into the ventricles. 
While adjacent atrial fibers are connected by gap junctions, the only 
electrical connection between the atria and the ventricles is via the 
atrioventricular (AV) node (Figure 2-2 on page 16). The action 
potential spreads slowly through the AV node and then rapidly 
through the Bundle of His and Purkinje fibers to excite both 
ventricles.

 Figure 2-2: A diagram of the human heart to show the 
location of the sinoatrial (SA) and atrioventricular (AV) 
Nodes.

The semilunar valves are located between the ventricle and the 
artery on each side of the heart. In the relaxed heart the high arterial 
pressure shuts the semilunar valves and prevents blood flow from the 
artery into the ventricle. Ventricular contraction increases the 
pressure of the blood in the ventricle. When the ventricular pressure 
is greater than the arterial pressure, the semilunar valves open and 
blood flows into the artery. The myocardium then relaxes, the 
ventricular pressure declines and the semilunar valves close.
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Experiment 2: Electrocardiogram and Heart 
Sounds

Overview The cardiac cycle involves a sequential contraction of the atria and 
the ventricles. The combined electrical activity of the different 
myocardial cells produces electrical currents that spread through the 
body fluids. These currents are so large that they can be detected by 
recording electrodes placed on the skin. In this lab you will attach 
three electrodes to a student volunteer. These electrodes will be 
connected to the ETH-256 and the signal will be displayed on the 
computer screen in a strip chart format. The regular pattern of 
peaks  produced by each heart beat cycle is called the electrocar-

diogram or ECG (Figure 2-3 on page 17).

 Figure 2-3: ECG trace in the Main window showing the P, 
QRS, and T waves; the cursors are positioned to measure the 
amplitude (in volts) of the QRS wave.

The action potentials recorded from atrial and ventricle fibers are 
different from those from nerves and skeletal muscle. The cardiac 
action potential is composed of three phases: a rapid depolarization, 
a plateau depolarization (which is pronounced in ventricular fibers), 
and a repolarization back to resting membrane potential. The compo-
nents of the ECG (Figure 2-3 on page 17) can be correlated with the 
electrical activity of the atrial and ventricle fibers such that:

¥ the P-wave is produced by atrial depolarization

¥ the QRS complex is produced by atrial repolarization and ventricle depolar-
ization

¥ the T-wave is produced by ventricle repolarization. 
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In this lab you will record the ECG from a volunteer. You will listen 
to the characteristic lub-dup  heart sounds. The lub  sound occurs 
during the early phase of ventricle contraction and is produced by 
closing of the atrioventricular valves, which prevents blood flow into 
the atria. When the ventricles relax the blood pressure drops below 
that in the artery and the semilunar valves close, producing the dup  
sound.

Equipment 
Required

PC computer

ETH-256 and National Instruments A/D Card

ECG cables and gray ECG unit

Alcohol swabs

Stethoscope

Event marker

Alcohol swabs

Equipment 
Setup

1 Connect the ETH-256 unit to the A/D card   (described in Chapter 1).

2 The volunteer should remove all jewelry from their wrists and ankles.

3 Use an alcohol swab to clean and abrade a region of each wrist which has 
little or no hair.

4 Remove the plastic disk from a disposable electrode and apply the 
electrode to the abraded area on one wrist. Repeat for the other wrist and 
one ankle. 

5 Attach the cable from the ECG pod unit to channel one on the ETH-256.

6 Attach one end of each of the three electrode cable to the pod unit and 
snap the other ends onto the disposable electrodes, so that:

¥ The + lead is attached to the right wrist

¥ The - lead is connected to the left leg

¥ The ground or reference lead is connected to the left wrist.

7 Use the DIN8 plug to connect the event marker to channel two (Figure 2-4 
on page 19).

8 Set the controls on the ETH-256 as follows:

Ch. 1: ECG pod Ch. 2: Event Marker

Gain x10 x1

High Pass 0.3 Hz DC

Low Pass 50Hz 50Hz
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9 The volunteer should sit quietly with their hands in their lap.

 Figure 2-4: The equipment used to measure the ECG from a 
volunteer.

Start the 
Software

1 Click the (Windows) Start menu, move the cursor to Programs and then to 
the iWorx folder and select LabScribe. 

2 When the program opens, select Load from the Settings menu.   

3 When the dialog box appears, select Human and then click OK.

4 Click on the Settings menu again and select the Heart #1 settings file.

5 After a short time, LabScribe will appear on the computer screen with the 
Heart #1 settings.

Exercise 1: 
ECG in a 
Resting 
Volunteer

Aim: To measure the ECG in resting individuals.

Procedure 1 Click Start and the click AutoScale in the channel one title area and see 
the rhythmic ECG signal. 

¥  If the trace is upside down (QRS goes down) click Stop and switch the 
positive and negative electrodes.

¥ If a larger signal is required, the electrodes should be moved from the 
wrists to the skin immediately below each clavicle.

2 Have the volunteer open and close their fists, or move their arms across 
their chest. Notice that the trace moves around the screen and the ECG is 
distorted. This should tell you that it is necessary to keep still and relaxed 
when recording the ECG.
Chapter 2: Cardiovascular Physiology 19



                             
3 When you have a suitable trace type "*** s resting ECG" (where *** is the 
volunteer s name) and press Enter on the keyboard.

4 Click Stop to halt recording; your data may look like Figure 2-3 on page 
17.

5 Select Save As in the File menu, type a meaningful name and save the 
file in an appropriate place on the hard drive. 

Data Analysis 1 Click the 2 cursor icon (Figure 2-5 on page 20), so that two blue vertical 
lines appear over the recording window.

2 Drag the cursors left and right so that four heart beat cycles are located 
between the two blue lines.

3 Click the Analysis icon (Figure 2-5 on page 20) to open the Analysis 
window.

 Figure 2-5: The LabScribe toolbar

4 Click to de-select channel two, to display only the ECG trace.

5 Use the mouse to click and drag the cursors around the Analysis window 
to measure:

¥  the amplitude (Max-min) of three QRS waves (shown in Figure 2-1).

¥ the amplitude (v2-v1) of three P waves.

¥ the amplitude (v2-v1) of three T waves.

¥ the time interval (t2-t1) between four adjacent QRS waves (you should 
have three values). Remember the display time can be changed in incre-
ments of two (as in the Main window) to expand the horizontal axis and 
obtain a very accurate time measurement and the trace can be scrolled 
horizontally using the arrows in the lower margin.

6 Data should be entered into the Journal either by typing the values 
directly, or by typing a title and then transferring the title and then each 
data set by right clicking in the Analysis window.
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7 Calculate (and type your results in your Journal):

¥ the average value for the amplitude of the P wave, the QRS wave, and the 
T wave.

¥ the average time interval (in seconds) between adjacent QRS waves and 
then calculate the heart rate as follows:

Heart rate =                          60 beats/minute

     mean time interval (s)

Questions 1 Is the amplitude of the different waves the same in different cardiac 
cycles?

2 Which wave has the largest amplitude? 

3 What is the heart rate?

Exercise 2: 
ECG 
Recordings 
from other 
Students 

Aim: To measure heart rate from all students.

Procedure 1 Disconnect the leads from the volunteers wrists and ankle and place them 
on a second student. Record their ECG as above (omit step #2).

2 Repeat until all students have recorded their ECG.

Data Analysis Make measurements as outlined above.

Questions 1 Is the amplitude of the different waves the same in different individuals? 
Why?

2 For each individual which wave has the largest amplitude? Is this result 
the same for all individuals?

3 Is the heart rate the same for each individual?

4 What variation is there within the class?

5 Is there any obvious correlation between heart rate and sex, apparent 
fitness, diet?
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Exercise 3: 
ECG and Heart 
Sounds

Aim: To measure the ECG in resting individuals.

Procedure

1 The operator should place the head of the stethoscope on the left side of 
the volunteer s chest and listen for the heart sounds. Move the stetho-
scope head to different positions until clear heart sounds are heard.

2 The operator should click Start and, holding the stethoscope head in one 
hand and the event marker in the other, press the event marker on lub  
and release on dup.  

3 After a few heart beat cycles, click Stop to halt recording.

4 Select Save in the File menu. 

Data Analysis Your data may look like Figure 2-6 on page 23. 

1 Click the 2 cursor icon (Figure 2-5 on page 20), so that two blue vertical 
lines appear over the recording window.

2 Drag the cursors left and right so that one heart beat cycle is located 
between the two blue lines.

3 Click the Analysis icon (Figure 2-5 on page 20) to open the Analysis 
window.

4 Use the mouse to click and drag one cursor to measure the time delay (t2-
t1) between:

¥ the peak of the QRS wave and the lub sound.

¥ the peak of the T wave and the dup sound.

5 Data should be entered into the Journal either by typing the values 
directly, or by typing a title and then transferring the title and then each 
data set by right clicking in the Analysis window.

6 Copy the trace and paste it into the Journal.

7 Repeat the above measurements with at least three other cardiac cycles.
Chapter 2: Cardiovascular Physiology 22



              
 Figure 2-6: An ECG (upper trace) correlated with heart 
sounds (lower trace).

Questions 1 Why is the lub sound recorded around the peak of the QRS wave?

2 Is the time delay between the QRS wave and the lub sound always the 
same? Should it be, and why is it not?

3 Why is the dup sound recorded around the peak of the T wave?

4 Is the time delay between the T wave and the dup sound always the 
same? Should it be, and why is it not?

Experiment 3: Electrocardiogram and Peripheral 
Circulation

Overview The arterial system functions as a pressure reservoir. Blood leaves 
the arterial system continuously through the capillaries, but enters 
intermittently from the heart. When the ventricles contract (called 
systole ) the semilunar valves open and blood passes into the 

arterial system. At this point the arteries expand and the blood 
pressure increases the maximum value is called the systolic 
pressure. The heart then relaxes (called diastole ), fills with blood 
from the veins, and begins to pump. During diastole blood flows out 
of the arterial system through the capillaries and the arterial pressure 
decreases. When the arterial blood pressure is at its lowest immedi-
ately before the contracting ventricle pushes blood into the arteries
this value is called the diastolic pressure. While the variation in 
arterial blood pressure during the cardiac cycle is smoothed out by 
the inherent elasticity of the major arteries, blood still exhibits 
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pulsatile flow through the arteries and arterioles. In this lab you will 
measure the pulsatile flow of blood through the finger of a student 
volunteer and correlate it with the ECG. In addition you will examine 
the effects of temperature on peripheral circulation.

Equipment 
Required

PC computer.

ETH-256 and National Instruments A/D Card

ECG cables and ECG pod unit

Alcohol swabs

Plethysmograph

Ice, cold and hot water, plastic bags

Equipment 
Setup

1 Connect the ETH-256 to the computer (described in Chapter 1).

2 The volunteer should remove all jewelry from their wrists and ankles.

3 Use an alcohol swab to clean and abrade a region of each wrist which has 
little or no hair.

4 Remove the plastic disk from a disposable electrode and apply the 
electrode to the abraded area on one wrist. Repeat for the other wrist and 
one ankle. 

5 Attach the cable from the gray ECG pod unit to channel one on the ETH-
256 unit.

6 Attach one end of each of the three electrode cables to the pod unit and 
snap the other ends onto the disposable electrodes, so that:

¥ The + lead is attached to the right wrist.

¥ The - lead is connected to the left leg.

¥ The ground or reference lead is connected to the left wrist.

7 Set the controls on the ETH-256 as follows

Ch. 1: ECG pod Ch. 2: Plethysmograph

Gain x10 x10

High Pass 0.3 Hz DC

Low Pass 50Hz 50Hz

8 Place the plethysmograph on the volar surface (where the fingerprints are 
located) of the distal segment of a middle finger; wrap the Velcro to attach 
the unit firmly to the end of the finger (Figure 2-7 on page 25).

9 Locate the DIN8 plug on the other end of the cable; push it into the 
channel two DIN8 receptacle.
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10 The volunteer should sit quietly.

 Figure 2-7: The equipment used to measure an ECG and 
blood flow from a volunteer.

Start the 
Software

1 Click the (Windows) Start menu, move the cursor to Programs and then to 
the iWorx folder and select LabScribe. 

2 When the program opens, select Load from the Settings menu.   

3 When the dialog box appears, select Human and then click OK.

4 Click on the Settings menu again and select the Heart #2 settings file.

5 After a short time, LabScribe will appear on the computer screen with the 
Heart #2 settings.

Exercise 1: 
ECG and 
Volume Pulse in 
a Resting 
Volunteer

Aim: To measure and correlate the ECG and volume pulse in a 
resting individual.

Procedure 1 Click Start and the click AutoScale in the channel one title area and see 
the rhythmic ECG signal. 

¥  If the trace is upside down (QRS goes down) click Stop and switch the 
positive and negative electrodes.

¥ If a larger signal is required, the electrodes should be moved from the 
wrists to the skin immediately below each clavicle.

2 Click AutoScale in the channel two and then the channel three title areas 
and see the rhythmic finger pulse signals get bigger. 
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3 Type ECG and finger pulse,  press Enter on the keyboard and click Stop 
to halt recording. Your data should look like Figure 2-8 on page 26.

4 Select Save As in the File menu, type a meaningful name and save the 
file in an appropriate place on the hard drive. 

 Figure 2-8: An ECG (upper trace), plethysmograph 
recording of blood flow (middle trace) and its integral (lower 
trace) shown in the Analysis window.

Data Analysis 1 Click the 2 cursor icon (Figure 2-9 on page 26), so that two blue vertical 
lines appear over the recording window.

2 Drag the cursors left and right so that two or three heart beat cycles are 
located between the two blue lines.

3 Click the Analysis icon (Figure 2-9 on page 26) to open the Analysis 
window.

 Figure 2-9: The LabScribe toolbar
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4 Click to de-select channel two to display the ECG and the integrated 
finger pulse traces.

5 Use the mouse to click and drag one cursor to the peak of the QRS wave 
and the second cursor to the peak of the next finger pulse signal (Figure 
2-8 on page 26). 

6 Enter the time (t2-t1) difference into the Journal either by typing the values 
directly, or by typing a title and then transferring the title and the data set 
by right clicking in the Analysis window.

Questions 1 What produces the QRS wave in the ECG?

2 What does the peak of the blood flow trace represent?

3 What processes, therefore, take place between these two events?

4 What, therefore, does this time value represent? 

5 Does the falling phase of the volume pulse have a small, transient plateau 
or upward deflection as shown in the upper trace of Figure 2-8 on page 
26 (arrow)? This is called the dicrotic notch.

6 Would you expect a transient increase in blood pressure as the elastic 
arteries recoil after being stretched by blood entering from the ventricles? 

Exercise 2: The 
Volume Pulse

Aim: To measure the volume pulse in other individuals.

Procedure 1 Remove the equipment from the volunteer  the ECG equipment is no 
longer needed.

2 Strap the plethysmograph to another student, make a recording and 
examine the volume pulse trace.

3 Repeat for all students and type comments to label the relevant sections 
of data with the students  names.

4 Select Save in the File menu.

Questions 1 Do all student traces have a dicrotic notch?

2 Is the size of the dicrotic notch correlated with age, smoking or fitness?
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Exercise 3: The 
Effect of Cold 
on Volume 
Pulse

Aim: To measure the effects of cold on volume pulse and heart rate.

Procedure 1 Strap the plethysmograph to the middle finger of the volunteer s left hand.

2 Make a recording for about one minute and type cold  on the keyboard.

3 Place a bag of ice and cold water on the left forearm and at the same time 
press Enter on the keyboard.

4 Record for about two minutes, type remove  and then simultaneously 
remove the ice and press Enter on the keyboard.

5 Record for about two minutes and click Stop to halt recording.

6 Select Save in the File menu.

Data Analysis 1 Use the two cursors to locate the first two good  adjacent peaks at the 
beginning of the race.

2 Use the cursors to measure:

¥ the amplitude of the two peaks; calculate the mean.

¥ the time interval between the two peaks; calculate the heart rate.

3 Repeat these measurements every 10 seconds through your trace to see 
the effects of cooling and subsequent recovery on peripheral circulation 
and heart rate. Note when ice was applied and removed in your Journal 
data table.

Questions 1 What is the effect of cooling on peripheral circulation?

2 What factors change peripheral circulation?

3 What is the effect of cooling on heart rate. Explain your observations.

Exercise 4: The 
Effect of Heat 
on Volume 
Pulse

Aim: To measure the effects of warm on volume pulse and heart 
rate.

Procedure 1 Move the plethysmograph to the middle finger of the right hand.

2 Repeat the above, but this time place a bag of hot water on the right 
forearm.
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Questions What is the effect of heat on peripheral circulation and heart rate? 
Explain your results.

Experiment 4: Exercise, the Electrocardiogram and 
Peripheral Circulation

Overview The arterial system functions as a pressure reservoir. Blood enters 
via the heart and exits through the capillaries. Signals from the 
autonomic nervous system control the tone of smooth muscle 
sphincters around the arterioles. In this way, the autonomic nervous 
system can control the distribution of blood to the various organs in 
the body. The distribution of blood that flows to a particular organ is 
influenced by local conditions. If there are cells that require arterial 
blood, due to a decline in pH or oxygen levels or an increase in 
carbon dioxide levels, smooth muscle sphincters open to permit 
blood into particular capillary beds.

At rest, the distribution of blood to a particular organ may be very 
different from that seen during exercise. For example, the blood flow 
to the gut decreases during exercise while blood flow to the skeletal 
muscles increases dramatically. Furthermore, the amount of blood 
flowing around the circulatory system may be increased several 
times. In this laboratory you will record the electrocardiogram and the 
finger pulse from a (healthy) volunteer. These parameters will be 
recorded when the volunteer is at rest and immediately after 
exercise.

Warning: This experiment involves exercise and an elevation of heart rate; 
this experiment should not be performed by anyone who is not healthy or has 
a personal or family history of cardiovascular or respiratory problems.

Equipment 
Required

PC computer

ETH-256 and National Instruments A/D Card

ECG cables and ECG pod unit

Alcohol swabs

Plethysmograph

Hand dynamometer
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Equipment 
Setup

1 Connect the ETH-256 unit to the A/D card   (described in Chapter 1).

2 The volunteer should remove all jewelry from their wrists and ankles.

3 Use an alcohol swab to clean and abrade a region of each wrist which has 
little or no hair.

4 Remove the plastic disk from a disposable electrode and apply the 
electrode to the abraded area on one wrist. Repeat for the other wrist and 
one ankle. 

5 Attach the cable from the ECG pod unit to channel one on the ETH-256 
unit.

6 Attach the snap end of each of the three electrode cables to the 
disposable electrodes, so that:

¥ The + lead is attached to the right wrist.

¥ The - lead is connected to the left leg.

¥ The ground or reference lead is connected to the left wrist.

7 Place the plethysmograph on the volar surface (where the fingerprints are 
located) of the distal segment of a middle finger; wrap the Velcro to attach 
the unit firmly to the end of the finger (Figure 2-10 on page 30).

8 Locate the DIN 8 plug on the other end of the plethysmograph cable; push 
it into the pod connector on channel two. 

9 Set the controls on the ETH-256 as follows:

Ch. 1: ECG pod Ch. 2: Plethysmograph

Gain x10 x10

High Pass 0.3 Hz DC

Low Pass 50Hz 50Hz

10 The volunteer should sit quietly.

 Figure 2-10: Equipment used to measure an ECG and blood 
flow from a volunteer.
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Start the 
Software

1 Click the (Windows) Start menu, move the cursor to Programs and then to 
the iWorx folder and select LabScribe. 

2 When the program opens, select Load from the Settings menu.   

3 When the dialog box appears, select Human and then click OK.

4 Click on the Settings menu again and select the Heart #3 settings file.

5 After a short time, LabScribe will appear on the computer screen with the 
Heart #3 settings.

Exercise 1: 
ECG and 
Volume Pulse in 
a Resting 
Volunteer

Aim: To measure and correlate the ECG and volume pulse in a 
resting individual.

Procedure 1 Click Start and the click AutoScale in the channel one title area and see 
the rhythmic ECG signal. 

¥  If the trace is upside down (QRS goes down) click Stop and switch the 
wrist electrodes.

¥ If a larger signal is required, the electrodes should be moved from the 
wrists to the skin immediately below each clavicle.

2 Click AutoScale in the channel two and then in the channel three title 
areas and see the rhythmic finger pulse and integrals signals get bigger. 

3 Type ECG and finger pulse,  press Enter on the keyboard and click Stop 
to halt recording. Your data should look like Figure 2-11 on page 32.

4 Select Save As in the File menu, type a meaningful name and save the 
file in an appropriate place on the hard drive. 
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 Figure 2-11: An ECG (upper trace), plethysmograph 
recording of blood flow (middle trace) and its integral (lower 
trace) shown in the Analysis window.

Exercise 2: 
ECG and 
Volume Pulse 
after Exercise

Aim: To measure and correlate the ECG and volume pulse immedi-
ately after exercise.

Procedure 1 Disconnect the ECG leads and the plethysmograph BNC connector from 
the ETH-256. Check that the ECG leads are not tangled.

2 Remember that the ECG leads are still attached to the electrodes, so the 
volunteer should exercise carefully (so as not to break the leads), but 
vigorously enough to elevate heart rate. Try walking up stairs.

3 Immediately after exercise, connect the two connectors into the ETH-256 
while the volunteer sits down and relaxes.

4 Click Start, and record until the heart (and breathing) rate have returned 
to normal; during this time type ECG and finger pulse recovery from 
exercise  and press the Enter key on the keyboard. Record for at least 
two minutes.

5 Click Stop to halt recording.

6 Select Save in the File menu.
Chapter 2: Cardiovascular Physiology 32



Data Analysis You should have traces for the resting individual and immediately 
after exercise. For the resting condition:

1 Click the 2 cursor icon (Figure 2-12 on page 33), so that two blue vertical 
lines appear over the recording window.

2 Drag the cursors left and right so that three heart beat cycles are located 
between the two blue lines.

3 Click the Analysis icon (Figure 2-12 on page 33) to open the Analysis 
window.

 Figure 2-12: The LabScribe toolbar

4 Click to de-select channels two and three to display only the ECG.

5 Use the mouse to click and drag the two cursors to measure (Figure 2-13 
on page 34) within each cardiac cycle (three measurements for each 
trace):

P-R time interval

R-T time interval

T-P time interval

Between cardiac cycles (two measurements for each trace):

R-R time interval
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 Figure 2-13: An ECG trace recorded from a volunteer with 
labels to indicate the time values to be measured during data 
analysis.

6 Enter the time (t2-t1) difference into the Journal either by typing the values 
directly, or by typing a title and then transferring the title and the data set 
by right clicking in the Analysis window.

Repeat the above measurements using the first good  ECG traces 
immediately after, 30 seconds after and 60 seconds after exercise. 
Enter your labeled data into your journal.

Questions 1 Look at the three values for the P-R interval in the resting person. Are they 
constant? Explain any variation.

2 Look at the three values for the P-R interval immediately after exercise. 
Are they constant? Explain any variation.

3 Look at the three values for the P-R interval 30 and then 60 seconds after 
exercise. Are the values constant within each set of data? Explain any 
variation and trends for the three sets of data obtained at different 
intervals (0, 30, 60 seconds) after exercise.

4 Repeat steps 1 through 3 for the R-T, T-R and R-R intervals.

5 Look at the two values for R-R interval at rest and for the three times after 
exercise. Are they the same? If not, why not. 

6 Calculate the differences in the mean values of the time values obtained 
at rest and immediately after exercise, and tabulate in your Journal.If the 
R-R interval is used to determine heart rate, can any of the other three 
intervals (P-R, R-T, or T-P) fully account for this change?
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More Data 
Analysis

1 Look at the finger pulse trace recorded immediately after exercise. 

2 Use the cursors to measure the amplitude of a signal every 10 seconds 
for the entire record, or until the signal has returned to a resting level for 
30 seconds (i.e. three or four measurements that are reasonably 
constant).

Questions 1 What is the effect of exercise on the rate of blood flow through the 
fingers?

2 Is it possible that blood flow may be effected more if the exercise is 
directed at the arm rather than a generalized change in circulation?

Exercise 3: 
Finger Pulse 
after Hand 
Exercise

Aim: To measure and correlate the ECG and volume pulse immedi-
ately after exercise.

Procedure 1 Disconnect the ECG leads from the volunteer.

2 Grasp the dynamometer in the palm of the left hand (the hand to which 
the plethysmograph is attached). 

Note: The dynamometer is not plugged in to the ETH-256 at this time.

3 Rhythmically squeeze the dynamometer bulb for a few minutes or until the 
forearm muscles fatigue.

4 Click Start and stop exercising record for three minutes or until the 
amplitude of the finger pulse signal has attained a reasonably constant 
level for one minute; during this time type Finger pulse recovery from 
arm exercise  and press the Enter key on the keyboard.

5 Click Stop to halt recording.

6 Select Save in the File menu.

Data Analysis 1 Look at the finger pulse trace recorded immediately after exercise. 

2 Use the cursors to measure the amplitude of a signal every 10 seconds 
for the entire record, or until the signal has returned to a resting level for 
30 seconds (i.e. three or four measurements that are reasonably 
constant) .

3 Enter your data into the Journal.
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Questions 1 What is the effect of hand exercise on the rate of blood flow through the 
fingers?

2 Compare the data from the first session of exercise. Are they the same or 
different? Explain your data.

Experiment 5: Blood Pressure, Peripheral 
Circulation and Body Position

Overview The ventricles contract to push blood into the arterial system and 
then relax to fill with blood before pumping once more. This inter-
mittent ejection of blood into the arteries is balanced by a constant 
loss of blood from the arterial system through the capillaries. When 
the heart pushes blood into the arteries there is a sudden increase in 
pressure, which slowly declines until the heart contracts again. Thus, 
the pressure in the arteries varies during the cardiac cycle, being at 
its highest level immediately after the ventricle contracts (systolic 
pressure) and at its lowest level immediately prior to the pumping of 
blood into the arteries (diastolic pressure). These two values are 
traditionally measured by a trained nurse using a stethoscope and a 
blood pressure cuff. The cuff is placed on the upper left arm and 
inflated to stop arterial blood flow to the arm  the cuff creates a high 
pressure which causes the arteries to collapse. The pressure in the 
cuff is released and when the systolic pressure in the arteries is 
greater than in the cuff, blood flows momentarily to the arm through 
the partially collapsed artery this is heard through the stethoscope 
and the systolic pressure is noted from the pressure gauge on the 
cuff. When cuff pressure declines to the diastolic pressure the sound 
heard through the stethoscope changes and this value is noted as 
the diastolic pressure. 

Measuring blood pressure using a blood pressure cuff and a stetho-
scope takes a great deal of practice. While this technique may not be 
easily applied in this laboratory, you will measure blood pressure 
using a blood pressure cuff and a plethysmograph unit. In addition to 
measuring the blood pressure from all willing participants, the effects 
of cuff location, body position and arm position will be examined.
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Warning: As explained above, this procedure involves stopping blood flow 
to the arm. This is potentially dangerous. Please take the following precau-
tions:

1 Know what you are doing ahead of time.

2 Do not leave the cuff inflated for any prolonged period of time (>30 
seconds).

3 The volunteer should flex and extend their fingers between experiments to 
maintain blood flow.

4 This experiment should be performed by healthy individuals who do not 
have a personal or family history of cardiovascular or respiratory 
problems. If possible, use more than one volunteer during the course of 
the lab session.

Equipment 
Required

PC computer

ETH-256 and National Instruments A/D Card

Plethysmograph

Blood pressure cuff

Equipment 
Setup

1 Connect the ETH-256 unit to the A/D card   (described in Chapter 1).

2 Untangle to plethysmograph cable.

3 Place the plethysmograph on the volar surface (where the fingerprints are 
located) of the distal segment of a middle finger; wrap the Velcro to attach 
the unit firmly to the end of the finger 

4 Push the DIN plug on the other end of the cable into the socket labeled 
channel one. 

5 Place the blood pressure cuff around the upper portion of the left arm, 
between the elbow and the shoulder.

6 Set the controls on the ETH 256 as follows:

Ch. 1: Pulse sensor Ch. 2: No Device

Gain x10 x1

High Pass DC DC

Low Pass 50Hz 50Hz

7 The volunteer should sit quietly.
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 Figure 2-14: The equipment used to measure blood flow 
from a volunteer.

Start the 
Software

1 Click the (Windows) Start menu, move the cursor to Programs and then to 
the iWorx folder and select LabScribe. 

2 When the program opens, select Load from the Settings menu.   

3 When the dialog box appears, select Human and then click OK.

4 Click on the Settings menu again and select the Heart #4 settings file.

5 After a short time, LabScribe will appear on the computer screen with the 
Heart #4 settings.

Exercise 1: 
Procedure for 
Measuring 
Blood Pressure

Aim: To measure blood pressure.

Procedure 1 Ask the volunteer to sit down and relax, with both hands in their lap.

2 Click Start and record the finger pulse.

3 Click AutoScale in the channel one title area and see the rhythmic signal 
get bigger. During this initial recording type a brief description of the 
experiment that is about to be performed and press Enter on the 
keyboard.

4 Inflate the cuff until the pressure is just above 200 mmHg  notice that the 
finger pulse disappears (Figure 2-15 on page 39).
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 Figure 2-15: A finger pulse recorded during blood pressure 
measurements. In this experiment a few pulses were recorded 
(left) before inflating the cuff around the left upper arm. As 
the pressure in the cuff exceeded that in the artery the volume 
pulse signal disappeared, indicating that blood circulation 
had ceased. As the cuff pressure was released (marked in 
20mmHg increments from 200) the signal appeared around 
120mmHg and level out around 80mmHg. 

5 Slowly release the cuff pressure; when the pressure reaches 200 press 
the Enter key on the keyboard do not type, use the comments marker as 
an indicator of pressure. Press the Enter key every time the pressure 
drops by 20mmHg. 

6 When the cuff reaches 40 click Stop and remove the cuff. The volunteer 
should flex and extend their fingers to encourage blood circulation

7 Select Save As in the File menu, type a meaningful name and save the 
file in an appropriate place on the hard drive. 

Data Analysis - 
Measuring Blood 
Pressure

Systolic Pressure

1 Click the 2 cursor icon (Figure 2-16 on page 40), so that two blue vertical 
lines appear over the recording window.

2 Drag the cursors left and right to place them on either side of a pair marks 
between which the finger pulse signal first appears (between 140 and 120 
in Figure 2-17 on page 40).

3 Click the Analysis icon (Figure 2-16 on page 40) to open the Analysis 
window.
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 Figure 2-16: The LabScribe toolbar

 Figure 2-17: The finger pulse trace showing the recording 
taken as cuff pressure declined from 140 (left) to 120 (right) 
mmHg.

4 Place one cursor on the peak of the smallest signal (Figure 2-17 on page 
40) and the second cursor on the Mark entered prior to the peak. Measure 
the time interval (t2-t1) and call this time value #1. Repeat with the 
second cursor on the comment entered after the peak call this time 
value #2.

5 Calculate:  value #2 x 20

 value #1 + value #2

6 Add this number to the lowest value in the bracket (100 in the above 
example) to give you the systolic pressure.
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Diastolic Pressure

Look at your recording and notice that the amplitude of the finger 
pulse increases until it reaches (and stays at) its largest amplitude.
Repeat the above for the largest peak to give you the diastolic 
pressure.

Exercise 2: 
Repeat the 
Measurement

Aim: To determine the accuracy of the blood pressure 
measurement.

Procedure Repeat the procedures outlined in exercise #1 using the same 
volunteer. 

Questions 1 Are the values for blood pressure (systolic and diastolic) identical? Can 
you explain any variation?

2 Since you are looking for changes in the volume pulse, would slowing the 
rate of pressure released from the cuff make your readings more 
accurate? 

Note: If you decide to slow the release of the cuff pressure, remember that 
restricting circulation for a prolonged period can be dangerous.

Exercise 3: 
Measurements 
from the Right 
Arm

Aim: Measure blood pressure from the right arm.

Procedure ¥ a control experiment: 

1 With the plethysmograph still on the left hand, place the cuff around the 
upper portion of the right arm.

2 Inflate the cuff does the finger pulse signal disappear? Deflate the cuff.
Why does the finger signal remain after inflation?

¥ the right arm:

1 Place the plethysmograph on the distal segment of the middle finger of 
the right hand and wrap the Velcro to attach the unit firmly to the end of 
the finger.
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2 Measure the blood pressure as described above, making two separate 
measurements.

Questions Are the values the same as those obtained for the left arm? Explain 
any differences

Exercise 4: 
Measurements 
with the Cuff on 
the Forearm

Aim: To examine whether the blood pressure declines with distance 
from the heart.

Procedure 1 Move the cuff from the upper right arm to the lower right arm.

2 Measure the blood pressure as described above.

Questions Are the values the same as those obtained with the cuff on the 
forearm? Explain your data.

Exercise 5: Arm 
Position

Aim: To examine the effects of gravity on blood pressure and 
peripheral circulation.

Procedure 1 Move the cuff to the upper left arm (this may be a good time to switch 
volunteers). 

2 Measure the amplitude of the finger pulse and blood pressure with both 
hands in lap.

3 Have the volunteer place their right hand on their head and repeat step 2.

4 Have the volunteer place their left hand on their head and repeat step 2.

Questions What is the effect of raising each hand on finger pulse and blood 
pressure in the left arm? Explain your results.

Exercise 6: 
Measurements 
from the Leg

Aim: Measure blood pressure and peripheral circulation from the 
leg.
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Procedure 1 The volunteer should sit and remove the left shoe and sock.

2 Place the plethysmograph on the distal segment of the big toe and wrap 
the Velcro to attach the unit firmly to the end of the toe. 

3 Wrap the cuff around the calf of the left leg.

4 Inflate the cuff and measure the blood pressure as described above, 
making two separate measurements.

Questions 1 Are the values the same as those obtained for the arms? Explain any 
differences.

2 What happens to finger pulse and blood pressure when:

¥ the volunteer lies down on the bench?

¥ the prone volunteer lifts their left leg perpendicular to the bench (support 
the leg with a chair)?

¥ the volunteer stands?

¥ after the volunteer has been standing for three minutes?

Experiment 6: Blood Pressure, Peripheral 
Circulation and Imposed Conditions

Overview The ventricles contract to push blood into the arterial system and 
then relax to fill with blood before pumping once more. This inter-
mittent ejection of blood into the arteries is balanced by a constant 
loss of blood from the arterial system through the capillaries. When 
the heart pushes blood into the arteries there is a sudden increase in 
pressure (called the systolic pressure ), which slowly declines until 
the heart contracts again (the lowest arterial pressure is called the 
diastolic pressure ). In the previous lab these two pressure values 

were measured from willing volunteers in a study of the effects of cuff 
location and body position on blood pressure.

In this lab there will be a long-term experiment and a series of 
short-term experiments. Volunteers engaged in the long-term exper-
iment will examine the effects of food additive on heart rate, blood 
pressure and peripheral circulation. Other volunteers will be engaged 
in a number of short-term experiments to see the effects of apnea, 
exercise and temperature on blood pressure and peripheral circu-
lation.
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Warning: As explained previously, this procedure involves stopping blood 
flow to the arm. This is potentially dangerous. Please take the following 
precautions:

1 Know what you are doing ahead of time.

2 Do not leave the cuff inflated for any prolonged period of time (>30 
seconds).

3 The volunteer should flex and extend their fingers between experiments to 
maintain blood flow.

4 This experiment should be performed by healthy individuals who do not 
have a personal or family history of cardiovascular or respiratory 
problems. If possible, use more than one volunteer during the course of 
the lab session.

Equipment 
Required

PC computer

ETH-256 and National Instruments A/D card

Plethysmograph

Blood pressure cuff

Plastic bag, ice, and cold and hot water

Equipment 
Setup

1 Connect the ETH-256 unit to the A/D card   (described in Chapter 1).

2 Untangle the plethysmograph cable.

3 Place the plethysmograph on the volar surface (where the fingerprints are 
located) of the distal segment of a middle finger; wrap the Velcro to attach 
the unit firmly to the end of the finger.

4 Push the DIN 8 plug on the other end of the cable into the socket labeled 
channel one.

5 Place the blood pressure cuff around the upper portion of the left arm, 
between the elbow and the shoulder.

6 Set the controls on the ETH-256 as follows:

Ch. 1: Plethysmograph Ch. 2: No Device

Gain x10 x1

High Pass DC DC

Low Pass 50Hz 50Hz

7 The volunteer should sit quietly.
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 Figure 2-18: The equipment used to measure blood flow 
from a volunteer.

Start the 
Software

1 Click the (Windows) Start menu, move the cursor to Programs and then to 
the iWorx folder and select LabScribe. 

2 When the program opens select Load from the Settings menu.   

3 When the dialog box appears select Human and then click OK.

4 Click on the Settings menu again and select the Heart #5 settings file.

5 After a short time, LabScribe will appear on the computer screen with the 
Heart #5 settings.

Exercise 1: 
Procedure for 
Measuring 
Blood Pressure

Aim: To measure blood pressure.

Procedure 1 Ask the volunteer to sit down and relax, with both hands in their lap.

2 Click Start and record the finger pulse.

3 Click AutoScale in the channel one title area and see the rhythmic signal 
get bigger. During this initial recording type a brief description of the 
experiment that is about to be performed and press Enter on the 
keyboard.

4 Inflate the cuff until the pressure is just above 200mmHg notice that the 
finger pulse disappears (Figure 2-19 on page 46).
Chapter 2: Cardiovascular Physiology 45



 Figure 2-19: A finger pulse recorded during blood pressure 
measurements. In this experiment a few pulses were recorded 
(left) before inflating the cuff around the left upper arm. As 
the pressure in the cuff exceeded that in the artery the volume 
pulse signal disappeared, indicating that blood circulation 
had ceased. As the cuff pressure was released (marked in 
20mmHg increments from 200) the signal appeared around 
120mmHg and level out around 80mmHg. 

5 Slowly release the cuff pressure; when the pressure reaches 200 press 
the Enter key on the keyboard do not type, use the comments marker as 
an indicator of pressure. Press the Enter key every time the pressure 
drops by 20mmHg. 

6 When the cuff reaches 40 click Stop and remove the cuff.The volunteer 
should flex and extend their fingers to encourage blood circulation

7 Select Save As in the File menu, type a meaningful name and save the 
file in an appropriate place on the hard drive. 

Data Analysis - 
Measure Blood 
Pressure

Systolic Pressure

1 Click the 2 cursor icon (Figure 2-20 on page 47), so that two blue vertical 
lines appear over the recording window.

2 Drag the cursors left and right to place them on either side of a pair marks 
between which the finger pulse signal first appears.

3 Click the Analysis icon (Figure 2-20 on page 47) to open the Analysis 
window.
Chapter 2: Cardiovascular Physiology 46



 Figure 2-20: The LabScribe toolbar

 Figure 2-21: The finger pulse trace showing the recording 
taken as cuff pressure declined from 140 (left) to 120 (right) 
mmHg.

4 Place one cursor on the peak of the smallest signal (Figure 2-21 on page 
47) and the second cursor on the Mark entered prior to the peak. Measure 
the time interval (t2-t1) and call this time value #1. Repeat with the 
second cursor on the comment entered after the peak (Figure 2-21 on 
page 47) call this time value #2.

5 Calculate:  value #2 x 20

 value #1 + value #2

6 Add this number to the lowest value in the bracket (100 in the above 
example) to give you the systolic pressure.
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Diastolic Pressure

Look at your recording and notice that the amplitude of the finger 
pulse increases until it reaches (and stays at) its largest amplitude. 
Repeat the above for the largest peak to give you the diastolic 
pressure.

Lab Procedure Two types of experiments will be performed in this lab, and student 
volunteers should participate in only one type of experiment:

Long-term experiment - in which measurements are taken every 20 
minutes throughout the lab.

Short-term experiments - in which measurements are taken during 
a manipulation conducted in the periods between the long-term 
experiment.

Exercise 2: 
Effects of Food 
Additives (long-
term)

The effect of food additives will be examined as a class project. If 
there are 10 groups, one individual from each group should partic-
ipate in the long-term project. One suggestion includes having each 
willing individual drink 12 ounces of one of the following:

¥ regular soda

¥ sugar-free soda

¥ decaffeinated, regular soda

¥ decaffeinated, sugar-free soda

¥ Water (control)

Other possible studies could include the effects of smoking a 
cigarette (if there are regular smokers in the class), aspirin and other 
non-prescription pain relievers, monosodium glutamate, and sports 
drinks with different levels of sugar and salt.

Procedure 1 Ask the volunteer to sit down and relax, with both hands in their lap.

2 With the cuff around the left upper arm and the plethysmograph on the left 
middle finger:

¥ Measure the volume pulse for 30 seconds.

¥ Inflate the cuff and slowly deflate to measure blood pressure.

3 Have the volunteer drink their designated soda.

4 Repeat steps #1 and #2 every 20 minutes (enter appropriate comments, 
including the time after the drink).
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 Figure 2-22: The integral of the plethysmograph signal in 
the Analysis window.

Data Analysis 1 Measure the blood pressure, the amplitude of the volume pulse (place the 
cursors prior to and at the peak of the pulse signal) and the time interval 
between successive pulses (Figure 2-22 on page 49). 

2 Use a line graph to show the effects over time.

Questions 1 Compare the data sets to see the effects of the different additives on 
blood pressure, peripheral circulation and heart rate.

2 Explain your results

The Short-Term 
Experiments

These should be performed by volunteers who are not engaged in 
the long-term project the long-term individuals can be responsible 
for data accumulation at this stage.

Exercise 3: 
Effects of 
Exercise

Aim: To examine the effects of exercise on blood pressure.

Procedure 1 Loosely attach the blood pressure cuff to the volunteer s left upper arm, 
and firmly wrap the plethysmograph s Velcro strap around the distal 
segment of the left middle finger.

2 Remove the plethysmograph s connector from the ETH-256 unit and ask 
the volunteer to hold it in their left hand.
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3 Ask the volunteer to exercise carefully, with minimal class disruption but 
rigorously enough to elevate heart rate. Try walking up and down stairs.

4 Immediately after exercise, reattach the connector to channel one.

5 Click Start, inflate the cuff and measure the blood pressure; after deflation 
type recovery from exercise  and press the Enter key on the keyboard.

6 Click Stop to halt recording.

7 Select Save from the File menu.

Data Analysis Measure blood pressure after exercise.

Questions Compare the blood pressure before and after exercise. Does 
exercise change blood pressure?

Exercise 4: 
Apnea (holding 
breath)

Aim: To examine the effects of apnea on blood pressure and 
peripheral circulation.

Procedure 1 If a new volunteer is used, first measure their resting blood pressure.

2 As a preliminary study, simply record volume pulse and have the 
volunteer take in a deep breath, hold it for as long as possible, and then 
breathe normally (type appropriate comments during the experiment).

Questions 1 What is the effect of periods of apnea on heart rate and the amplitude of 
the volume pulse? 

2 Are there any changes when breathing is initiated once more?

3 Explain your results. Do you think apnea has an effect on blood pressure?

Procedure Repeat the above procedure and measure blood pressure when the 
volunteer in holding their breath.

Questions 1 What is the effect of apnea on blood pressure? 

2 Explain your results.
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Exercise 5: 
Cooling the 
Forearm

Aim: To examine the effects of cooling the forearm on blood 
pressure, heart rate and peripheral circulation.

Procedure 1 Place the plethysmograph on the right middle finger.

2 Record volume pulse for 60 seconds.

3 Apply a bag of ice water on the volunteer s right forearm.

4 Remove after two minutes and record during recovery until the volume 
pulse trace is reasonably consistent in amplitude for about 30 seconds.

Data Analysis 1 Select the first two good  adjacent peaks at the beginning of the volume. 
pulse trace.

2 Use the two cursors to measure:

¥ the amplitude of the two peaks; calculate the mean.

¥ the time interval between the two peaks; calculate the heart rate.

3 Repeat these measurements every 15 seconds through your trace to see 
the effects of cooling and subsequent recovery on peripheral circulation 
and heart rate. Note when ice was applied and removed.

4 Graph your results with respect to time, indicating the time when ice was 
applied and removed.

Questions 1 What is the effect of cooling on peripheral circulation and heart rate? 
Explain your data.

2 Would you expect blood pressure to change during this process?

Procedure 1 Place the plethysmograph on the left middle finger and the cuff on the left 
upper arm.

2 Repeat the above procedure, but measure blood pressure quickly after 
the ice bag has been applied to the left forearm.

Questions What is the effect of cooling on blood pressure? Explain your data.
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Exercise 6: 
Warming the 
Forearm

Aim: To examine the effects of warming the forearm on blood 
pressure, heart rate and peripheral circulation.

Procedure Repeat Exercise #5, except use a bag of warm water and another 
volunteer.
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Chapter 3: Neuromuscular 
Physiology

Overview
The bones of the skeleton provide support for the body and artic-

ulate at joints, which act as pivots points. The associated skeletal 
(or striated) muscles have bundles of collagen, called tendons, 
connecting them to the bones. These points of muscle attachment 
are usually close to the joint, so that a small contraction produces a 
large movement. Two or more muscles usually work antagonistically 
so that a contraction of one stretches the other.

Striated muscle is composed of multi nucleate cells called fibers. 
Each fiber consists of numerous thread-like myofibrils which have a 
banded appearance created by a series of repeated units, called 
sarcomeres, joined end-to-end. The ends of the sarcomere are 
marked by Z lines, the I band lies on either side of the Z line, and 
the A band is found in the center of the sarcomere (Figure 3-1 on 
page 53). The I band is composed of thin filaments which project 
from the Z line while the A band has thick filaments and overlapping 
thin filaments (Figure 3-1 on page 53).

 Figure 3-1: A diagram of a sarcomere showing the Z lines, 
I bands and A band (upper) and the associated protein 
filaments (lower).
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Thick filaments are made up of the protein myosin. A myosin 
molecule is composed of two polypeptide chains, each with a 
globular head  and a long tail  (Figure 3-2 on page 54). Myosin 
molecules are laid down so that the tails form the body  of the thick 
filament, and the heads hang off. Thin filaments are composed 
primarily of actin (Figure 3-2 on page 54), which form a double helix 
and have binding sites for myosin. According to the sliding filament 
theory the thick and thin filaments slide across one another to 
shorten the sarcomere. This is achieved by a reaction between the 
myosin heads and the actin molecules to form cross bridges.  The 
rapid making and breaking of these bonds together with the confor-
mational (shape) changes in the myosin head, produces the tension 
required to create a contraction.

 Figure 3-2: Diagrams of the myosin molecule and an actin 

filament  each sphere represents a molecule of globular 

actin in the helical chain.

In skeletal neuromuscular systems, an action potential in a motor 
axon produces an action potential in the muscle fibers it innervates. 
This activity increases the intracellular level of calcium, which binds 
to troponin, a globular regulatory protein on the thin filaments. The 
resultant change in the shape of troponin effects the location of 
tropomyosin, a second associated regulatory protein on the thin 
filaments, and exposes the myosin binding sites on the actin 
molecules. Cross bridges between the myosin and actin are 
repeatedly made and broken to shorten the sarcomeres. Thus, the 
muscle contracts during the transient period when the level of 
calcium inside the muscle is elevated.
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Experiment 7: Electromyograms (EMGs)

Overview A skeletal muscle fiber is innervated by a branch of a motor neuron. 
Under normal circumstances a neuronal action potential activates all 
of the muscles innervated by the motor neuron. This activation 
process involves an action potential and a contraction of the 
muscle s fibers. During a contraction, therefore, there is synchronous 
activity in a number of fibers in the same muscle. The electrical 
signal recorded from a contracting muscle is called an 
electromyogram or EMG. As in the electrocardiogram (ECG), this 
activity can be detected by electrodes placed on the skin; in fact, 
such electrical activity was recorded during finger movements in 
Exercise #1 of Experiment 2. A muscle contraction is produced by 
one or more action potentials in many fibers. The EMG, therefore, is 
not a series of predictable waves seen during the ECG, but a burst of 
seemingly spike-like signals. On-line integration helps reading this 
complex signal, since the wave gives an indication of the intensity of 
muscle activity during a contraction.

In this lab you will record EMGs from arm muscles and examine 
recruitment, tetanus, and temporal motor activity to antagonistic 
muscles.

Equipment 
Required

PC computer

ETH-256 and National Instruments A/D card

EMG cables and black pod unit

Alcohol swabs

Equipment 
Setup

1 Connect the ETH-256 unit to the A/D card   (described in Chapter 1).

2 The volunteer should remove all jewelry from their wrists and ankles.

3 Use an alcohol swab to clean and abrade the three regions for electrode 
attachment on the right forearm, as shown in Figure 3-3 on page 56.

4 Remove the plastic disk from a disposable electrode and apply the 
electrode to one abraded area. Repeat for the other two areas. 

5 Attach the cable from the black pod unit to channel one on the ETH-256 
unit.
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6 Set the controls on the ETH-256 as follows:

Ch. 1: EMG Ch. 2: No Device

Gain x10 x1

High Pass 3 Hz DC

Low Pass 5KHz 50Hz

7 Attach the three electrode cables to the pod unit and snap the other ends 
onto the disposable electrodes, as shown in Figure 3-3 on page 56.

8 The volunteer should hold a small object (like keys or a pen knife) in their 
right hand.

 Figure 3-3: The equipment used to monitor EMGs and 
resulting finger movements from a volunteer.

Start the 
Software

1 Click the (Windows) Start menu, move the cursor to Programs and then to 
the iWorx folder and select LabScribe. 

2 When the program opens, select Load from the Settings menu.   

3 When the dialog box appears, select Human and then click OK.

4 Click on the Settings menu again and select the Muscle #1 settings file.

5 After a short time, LabScribe will appear on the computer screen with the 
Muscle #1 settings.

Exercise 1: 
Recruitment 
and the EMG

Aim: To examine the EMG when more fibers are recruited into a 
single twitch.
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Procedure 1 Click Start and the click AutoScale in the channel one title area then 
AutoScale channel two.

2 Ask the volunteer to squeeze the object in their hand using a single, brief 
contraction (twitch) of the fingers. Start with a gentle contraction and 
gradually increase the intensity of the single twitch contractions until a 
maximum level is reached; press Enter on the keyboard at each 
contraction.

3 Type EMG and increasing twitches,  press Enter on the keyboard and 
click Stop to halt recording. 

4 Select Save As in the File menu, type a meaningful name and save the 
file in an appropriate place on the hard drive. 

Data Analysis 1 Right click on the channel two display area and select Integrate.

2 Scroll the first twitch recording to the center of the screen.

3 Click the 2 cursor icon (Figure 3-4 on page 57), so that two blue vertical 
lines appear over the recording window and are located on either side of 
the first response.

4 Click the Analysis icon (Figure 3-4 on page 57) to open the Analysis 
window.

 Figure 3-4: LabScribe toolbar

5 Use the mouse to click and drag one cursor to the baseline, prior to the 
first response, and the second cursor on the peak of the response on 
channel two.

6 Click in the top left margin to select data values from channel two and 
enter the voltage (v2-v1) difference into the Journal either by typing the 
values directly, or by right clicking in the Analysis window and selecting 
Add Data to Journal.

7 Repeat for all responses.
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 Figure 3-5: The EMG recording during three increasing 
finger movements.

Questions 1 Is there a correlation between the amplitude of the integrated EMG signal 
and the amount of contraction?

2 Look at your data. Is the duration (length) of each integrated signal about 
the same for each contraction? If not, this would indicate more than just a 
single muscle twitch i.e. some muscle fibers were stimulated for more 
than just a single action potential in the motor neurons.

3 Are all of the EMG responses approximately the same duration?

4 How do you explain the increase in the amplitude of the integrated EMG 
signal with an increase in contraction?

Hint: If a contraction involves a single twitch of the contracting muscle 
fibers, how can contraction be increased without making muscle fibers more 
than once?

Exercise 2: 
Maximum 
Finger 
Contraction

Aim: To measure the EMG when the fingers are squeezed hard.

Procedure 1 Click Start and type hard squeeze.

2 Ask the volunteer to squeeze the object in their hand as hard as possible 
to produce maximum tension, press Enter on the keyboard, and then 
relax.
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3 Click Stop to halt recording. 

4 Select Save in the File menu. 

 Figure 3-6: An EMG recording during a maximum 
contraction.

Data Analysis Your EMG data may look like Figure 3-6 on page 59.

1 Click the 2 cursor icon (Figure 3-4 on page 57), so that two blue vertical 
lines appear over the recording window and are located on either side of 
the maximum response.

2 Click the Analysis icon (Figure 3-4 on page 57) to open the Analysis 
window.

3 Use the mouse to click and drag:

¥ one cursor to the baseline, prior to the first response, and the second 
cursor on the peak of the response on channel one read off the response 
amplitude (v2-v1).

¥ one cursor to the beginning of the response and the other to the end of the 
response on channel one read off the duration (t2-t1) of the contraction.

For all data enter the data values into the Journal either by typing 
them directly, or by typing a title and then transferring the title and 
the data set by right clicking in the Analysis window.

4 Repeat the above measurements for the last response in the previous 
exercise i.e. the largest  single twitch.
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Questions 1 Using the EMG integral data, compare the amplitude of the maximum 
squeeze with the maximum single twitch contraction which is larger? 

2 If all fibers were contracting in both instances (maximum squeeze and 
single twitches) explain why the maximum squeeze produced a larger 
contraction.

3 Compare the duration of this maximum squeeze contraction with the 
maximum contraction produced by a single twitch which is longer?

4 Does your answer to question #2 fit with your answer to question #3?

Hint: During the second exercise do you think each motor axon fired only 
once to produce the maximum squeeze?

Exercise 3: 
Tetanus and 
Movement

Aim: To examine the relationship between tetanus and movement.

Procedure Move the recording electrodes to the biceps as follows:

1 Remove the recording electrodes from the forearm and place them on the 
biceps as shown in Figure 3-7 on page 60.

 Figure 3-7: The equipment used to monitor EMGs from the 
biceps muscle of a volunteer.

2 Ask the volunteer to sit on a chair and support their right elbow with their 
left hand. Ask the volunteer to make a fist with their right hand and place 
the knuckles under the bench top with their palm uppermost.

3 Click Start and type tetanus.
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4 Ask the volunteer to bend their right arm against the weight of the bench 
top, press Enter on the keyboard.

5 After 15 seconds of hard contraction ask the volunteer to stop, extend 
their arm and relax (the left hand should still support the right elbow). 
Does the right arm bend when the biceps is relaxed? Is there any 
myogram activity in the biceps muscle when the arm bends?

6 Click Stop to halt recording. 

7 Select Save in the File menu. 

Questions 1 During the contraction did the angle between the upper arm and lower 
arm change significantly?

2 When the volunteer relaxed after the contraction, were EMGs recorded?

3 During relaxation did the angle between the upper arm and lower arm 
change significantly?

4 How can you explain a movement in the absence of significant EMG 
activity?

Hint: Does the level of intracellular calcium return to normal immediately 
after a contraction?

Exercise 4: 
Integration of 
Motor Activity

Aim: To study activity in antagonistic muscles during normal 
movement.

Procedure 1 Ask the volunteer to sit on a chair and support their right elbow with their 
left hand. 

2 Click Start and type no weight - biceps  and press Enter on the keyboard.

3 Ask the volunteer to bend and extend their arm slowly type bend  and 
press Enter every time they bend their arm. Does the right arm bend or 
extend when the biceps is relaxed? Is there any myogram activity in the 
biceps muscle when the arm extends? 

4 Repeat the above contracting against a reasonably heavy weight like a 
book bag (type and Enter a Mark to annotate your record).

5 Click Stop to halt recording. 

6 Select Save in the File menu. 

7 Move the electrodes to the (antagonistic) triceps muscle and repeat the 
above.
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Questions Look at your data:

1 Is the EMG activity greater when moving the book bag than without? 
What does this tell you about the relationship between motor neuron 
activity, EMGs and muscle performance and work?

2 When the bag is held at arm s length, is EMG activity constant for the 
duration of the experiment, or did it increase?

3 With a constant load being lifted, why would muscle activity increase?

Experiment 8: Reflexes and Reaction Times

Overview During our day-to-day lives we detect changes in the environment 
and react appropriately. An external stimulus is detected by one or 
more neurons, which send the sensory information to the central 
nervous system, where it is processed. If a motor response is 
initiated, it usually involves a series of action potentials that produce 
a muscle contraction and a movement of one or more parts of the 
body. A simple reflex is perhaps the easiest of this type of stimulus-
response reaction. A loud sound or something flying at your eye 
make you blink, while a tap on the tendon under the knee cap 
produces the knee-jerk (or myotactic) reflex.

 Figure 3-8: A cross section of the spinal cord showing the 
single synapse between the sensory and the motor neurons 
involved in the myotactic reflex.
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A simple reflex like the myotactic reflex is produced via single 
synapses between sensory axons and motor neurons. The required 
circuitry for this reflex is confined to the spinal cord, as shown in 
Figure 3-8 on page 62. Sensory information also ascends to higher 
centers, but the brain is not necessary or required to perform the 
reflex. More complex reflexes usually involve additional (inter-) 
neurons and more than one population of motor neurons. Thus, more 
neurons and synapses are involved, which usually results in a longer 
delay between stimulus and response, and often a more complex 
response. One example of such a complex response is the flexion 
withdrawal reflex, where a noxious stimulus to one leg causes 
withdrawal of the stimulated leg and extension of the other.

In this lab you will study the time taken between a stimulus and the 
response. These reaction time measurements will be made from a 
volunteer subjected to harmless visual and sound stimuli. In addition, 
the effect of priming and prediction will be examined.

Equipment 
Required

PC computer

ETH-256

Event marker

Plethysmograph

Equipment 
Setup

1 Connect the ETH-256 unit to the A/D card (described in Chapter 1).

2 Plug the event marker into the DIN8 socket on channel one.

3 Plug the plethysmograph into the DIN8 socket on channel two.

4 The equipment should look like Figure 3-9 on page 63.

 Figure 3-9: The equipment used to measure reaction times 
from a volunteer.
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Start the 
Software

1 Click the (Windows) Start menu, move the cursor to Programs and then to 
the iWorx folder and select LabScribe. 

2 When the program opens, select Load from the Settings menu. 

3 When the dialog box appears, select Human and then click OK.

4 Click on the Settings menu again and select the Muscle #3 settings file.

5 After a short time, LabScribe will appear on the computer screen with the 
Muscle #3 settings.

Exercise 1: 
Reaction Time 
and Sound

Aim: To measure the reaction time of a volunteer to a sound.

Procedure 1 Ask the volunteer to sit in a chair placed in a location so that their back is 
facing the computer screen with the keyboard immediately behind them.

2 Ask the volunteer to relax and listen as another student taps the white 
surface of the plethysmograph with a pencil. Ask the volunteer if they can 
hear the tapping sound.

3 Ask the volunteer to (quickly) click the event marker as soon as they hear 
the tap.

4 Click Start. 

5 Present a total of 10 taps, but make sure that the taps are delivered so 
that the volunteer cannot predict when the stimulus will be presented.

6 Click Stop to halt recording.

7 Select Save As in the File menu, type a meaningful name and save the 
file in an appropriate place on the hard drive. 

Data Analysis 1 Click the 2 cursor icon (Figure 3-10 on page 65), so that two blue vertical 
lines appear over the recording window.

2 Drag the cursors left and right so that the large spike on the plethysmo-
graph channel and the signal from the event marker are located between 
the two blue lines.

3 Click the Analysis icon (Figure 3-10 on page 65) to open the Analysis 
window.
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 Figure 3-10: The LabScribe toolbar

4 Use the mouse to click and drag one cursor to the beginning of the spike 
on the plethysmograph channel and the second cursor to the onset of the 
signal from the event marker (Figure 3-11 on page 65). 

5 Enter the time (t2-t1) difference into the Journal either by typing the values 
directly, or by right clicking in the Analysis window and electing Send 
Data/Titles to the Journal.

6 Use the scroll bars to scroll through your data in the Analysis window and 
repeat the measurements for all 10 trials.

7 Omit the longest and shortest values and average the remaining eight 
values to give the mean reaction time.

 Figure 3-11: Data produced by tapping the plethysmograph 
which entered a a large spike on CH 2 and produced a 
sound, which the volunteer used as a cue to press the event 
marker (trace). The cursors are positioned to measure the 

reaction time the time between the mark and the first 

response.
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Exercise 2: 
Reaction Time 
and Prompted 
Sounds

Aim: To measure the reaction time of a volunteer to sounds 
delivered immediately after a verbal prompt.

Procedure Repeat exercise #1, but ask the volunteer if they are ready immedi-
ately prior to tapping the plethysmograph.

Data Analysis Measure the interval between stimulus and response for each 
event.

Exercise 3: 
Reaction Time 
and Predictable 
Sounds

Aim: To measure the reaction time of a volunteer to sounds 
delivered at a predictable interval.

Procedure Repeat exercise #1, but tap the plethysmograph at a predictable 
interval.

Data Analysis Measure the interval between stimulus and response for each 
event.

Questions 1 Is the average reaction time the same for all three conditions?

2 Does the interval decrease during exercises 2 and 3?

Exercise 4: 
Reaction Time 
and Visual Cues

Aim: To measure the reaction time of a volunteer to a visual cue.

Procedure 1 Ask the volunteer to sit in a chair and face the computer screen.

2 Ask the volunteer to watch the screen and (quickly) press the event 
marker button as soon as they see the trace deflection.

3 Click Start; a second student (out of site) should tap the plethysmograph 
(and the volunteer should respond).

4 Present a total of 10 trials, but make sure that the events are delivered so 
that the volunteer cannot predict when the visual cue will be presented.
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5 Click Stop to halt recording.

6 Select Save from the File menu.

Data Analysis Your result should look like Figure 3-11 on page 65. 

1 Use the cursor and the marker to measure the time delay between visual 
stimulus and response.

2 Repeat the measurements for all 10 trials.

3 Omit the longest and shortest values and average the remaining eight 
values to give the mean reaction time.

Questions Is the average reaction time comparable to the data from exercise 
#1? What does this tell you about the time taken to react to oral and 
visual cues?

Exercise 5: 
Reflexes

Aim: To examine different reflexes.

The Knee-Jerk 
Reflex

1 Ask the volunteer to sit in a chair and cross their legs.

2 Firmly strike the tendon below the knee cap and watch the knee jerk.

3 Ask the volunteer to cup and link their hands, and then pull outwards (this 
is the Jendrassil maneuver). Repeat step #2. 

What effect does Jendrassil maneuver have on the knee-jerk reflex. 
Can you explain why?

The Papillary 
Reflex

1 Shade the eyes for 30 seconds.

2 Shine a light into one eye. What is the response of the pupil?

3 Repeat steps 1 and 2, but note the response of the unstimulated eye.

What is the effect of light on the eyes? Can you explain why this 
reflex would be beneficial to you?

The Spinociliary 
Reflex

1 A student should look into one of the volunteer s eyes. 

2 The student should gently stroke the hair in the hair line behind one ear. 
What is the effect on the pupil?

3 Repeat step #2 but stroke the hair behind the other ear

Can you explain why this reflex would be beneficial to you?
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Chapter 4: External Respi-
ration

Overview
Respiration is the process by which the body obtains oxygen and 

eliminates carbon dioxide. Internal respiration involves the 
metabolic processes that occur within mitochondria. External respi-
ration, however, describes the exchange of oxygen and carbon 
dioxide between the cells and the environment. You will examine 
human breathing in the next three laboratories in a study of external 
respiration. 

The human respiratory system consists of a series of tubes that 
branch and terminate as clusters of small membranous air sacs 
called alveoli. Oxygen and carbon dioxide cross the wall of the 
alveoli between the air and the blood. Factors that influence 
diffusion include a surface area, diffusion distance, and concen-
tration gradient. The alveoli provide a surface area about the size of 
a tennis court, and their thin walls provide a short diffusion distance. 
A high concentration gradient is insured by (1) directing blood with 
low oxygen and high carbon dioxide levels to the lungs and (2) 
pulmonary ventilation (breathing), which maintains a high level of 
oxygen and a low level of carbon dioxide in the alveolar air. Thus, 
the alveoli and associated blood supply are well suited for the 
diffusion of oxygen into the blood and carbon dioxide into the 
alveoli.

Ventilation of the human lung is produced by muscular contraction. 
The resulting change in thoracic volume is conveyed to the elastic 
lungs by the fluid-filled pleural cavity. Inspiration is achieved by a 
contraction of the diaphragm and the intercostal muscles, both of 
which increase the volume of the thoracic cavity. In the resting 
individual expiration is usually passive since muscle relaxation and 
gravity act to decrease thoracic volume. Under certain circum-
stances, like during exercise, forced expiration is produced by 
contraction of intercostal muscles.

The amount of air that moves in or out of the lungs during any one 
breathing cycle is called the tidal volume. This is not the maximum 
amount of air that can be moved through the lungs (the vital 
capacity), since there are reserve volumes that can be tapped  to 
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change the tidal volume. While the depth of breathing can be altered 
in this way, the rate of breathing can also be changed. These two 
parameters are controlled by the respiratory control center, which is 
located in the medulla of the brain. The center insures that the 
exchange of oxygen and carbon dioxide at the lungs takes place at a 
rate that matches the body’s requirements. This is a dynamic 
process, since the body s requirements change over time. This is the 
subject of the first laboratory, which examines breathing in a 
volunteer at rest and immediately after exercise. The second 
laboratory investigates the effect of gravity on breathing, while the 
third exercise looks at other factors that influence the rate and depth 
of breathing.

Experiment 9: Breathing Parameters at Rest and 
after Exercise

Overview The amount of air that moves in or out of the lungs during any one 
breathing cycle is called the tidal volume. After normal inspiration it is 
possible to breathe in additional air  this is called the inspiratory 
reserve volume. Similarly, after a normal expiration it is possible to 
exhale additional air from the lungs this is called the expiratory 
reserve volume. In this latter case, even if the expiratory reserve 
volume is fully expelled from the lungs, there is still air in the 
lungs.This non-exhaleable amount of air is called the residual 
volume.   Clearly, this tidal flow of air through the lungs results in the 
mixing of the fresh air with residual air. Since this residual air has 
been in the lungs it has a lower oxygen level and higher carbon 
dioxide level than fresh air. It is, therefore, not surprising that air in 
the alveoli is a mixture of stale  and fresh  air.

The respiration center in the medulla insures that gaseous 
exchange at the lung matches the requirements of the body. During 
times of increased demand the tidal volume can be increased, using 
some of the reserve lung volumes, to bring more fresh air into the 
body. In addition, the rate of breathing and the rate of air movement 
into and out of the lungs can be changed. In this lab you will measure 
these parameters in a volunteer at rest and immediately after 
exercise, when the body s demands for oxygen have been elevated.
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Equipment 
Required

PC computer

ETH-256 and A/D Card

Spirometer flow head and plastic tubes

SP-100, spirometer unit with cable

Equipment 
Setup

1 Connect the ETH-256 unit to the A/D card   (described in Chapter 1).

2 Firmly push the two air flow tubes into the two outlets on the flow head. 

3 Firmly push the other ends of the two air flow tubes into the two outlets on 
the SP-100 spirometer unit.

4 Use the cable to connect the output on the spirometer unit to the input on 
channel one of the ETH-256 (Figure 4-1 on page 71).

 Figure 4-1: Connect the spirometer to the ETH-256 unit.

5 Set the controls on the ETH-256 as follows:

Ch. 1: Spirometer Pod Ch. 2: No Device

Gain x1 x1

High Pass DC DC

Low Pass 50Hz 50Hz

Start the 
Software

1 Click the (Windows) Start menu, move the cursor to Programs and then to 
the iWorx folder and select LabScribe. 

2 When the program opens, select Load from the Settings menu. 

3 When the dialog box appears, select Human and then click OK.

4 Click on the Settings menu again and select the Lung #1 settings file.

5 After a short time, LabScribe will appear on the computer screen with the 
Lung #1 settings.
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Before Starting 1 The spirometer will monitor breathing from a volunteer. It is important that 
the volunteer is healthy and has no history of respiratory or cardiovascular 
problems.

2 The tubes on the flow head should always be in the upright position, to 
avoid problems with condensation.

3 Turbulent air flow through the flow head will produce a noisy signal.To 
avoid turbulent air flow be sure that the flow head opening is well inside of 
the mouth. Remember that air that enters or leaves through the nose is 
not counted in the volume calculation and will cause errors in the reading

4 The spirometer will display flow on channel one. The software is set to 
integrate the data you are recording on channel one and display it as a 
volume on channel two. The LabScribe software will report volume in 
liters on channel two using a conversion factor of 150 mVsec/liter. If the 
calibration number written on the spirometer serial number tag is larger or 
smaller (by more than 10%) than 150mV sec/liter you may have to recali-
brate channel two. Check to be sure that the software is set to integrate 
the flow data by moving the mouse to place the cursor over channel two, 
right click the mouse and check that the Integrate option is checked. If it is 
not checked, select it now. 

Exercise 1: 
Breathing in a 
Resting 
Volunteer

Aim: To measure breathing parameters in a resting individual.

Procedure 1 The volunteer should hold the spirometer head with the air flow tubes up. 
Breath normally this is difficult when you think about it! The volunteer 
should sit quietly and become accustomed to breathing through the 
spirometer.

2 With the resting volunteer breathing normally through the spirometer, click 
Start, type resting  and press Enter on the keyboard.

Note: The LabScribe software does a zero calibration during the first second 
of recording. No air should be moving through the flow head during this time. 

3 Click AutoScale in the channel one title area. Notice the slow wave on 
channel two as the volunteer breathes in and out. 

4 Type InMax, ,ask the volunteer to inhale as much as possible and press 
Enter on the keyboard. Quickly type OutMax, ,ask the volunteer to exhale 
as much as possible and press Enter on the keyboard. The volunteer 
should return to normal breathing through the spirometer.

5 Click Stop to halt recording. 
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6 Select Save As in the File menu, type a meaningful name and save the 
file in an appropriate place on the hard drive. 

Data Analysis - 
Measurements

Your data may look something like Figure 4-2 on page 73. 

 Figure 4-2: A recording in the Main window from a resting 
volunteer breathing through the spirometer (upper trace) and 
its integral (lower trace). The trace shows a normal 
breathing cycle (left) and then a forced inspiration and 
expiration (right).

1 Click the 2 cursor icon (Figure 4-3 on page 74), so that two blue vertical 
lines appear over the recording window.

2 Adjust the Display Time (Figure 4-3 on page 74) if necessary, drag the 
cursors left and right so that at least one breathing cycle is located 
between the two blue lines.

3 Click the Analysis icon (Figure 4-3 on page 74) to open the Analysis 
window.
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 Figure 4-3: The LabScribe toolbar

4 Use the mouse to click and drag the two cursors to measure, for each of 
the 5 breathing cycles (prior to the forced inhale and exhale):

¥ Tidal volume (TV): amplitude of each of the five breathing cycles (base to 
peak as shown in Figure 4-4 on page 74); average the five voltage values; 

 Figure 4-4: The spirometer signal (upper trace) and its 
integral (lower trace) recorded from a resting volunteer and 
displayed in the Main window; an upward deflection of the 
upper trace represents inspiration. The cursors are 
positioned on the peak and trough of the integrated signal to 
measure the tidal volume

¥ The duration of each of the five breathing cycles is easiest to measure 
from peak to peak in the air flow record (channel two) as shown in Figure 4-5 
on page 75; average the five values to obtain the mean time taken for each 
breath.
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 Figure 4-5: The integral of the spirometer signal recorded 
from a resting volunteer and displayed in the Main window. 
The cursors are positioned on the peaks of successive signals 
to measure the time interval.

¥ The maximum rate of air movement during exhalation from the lung 
volume recorded on channel three. 

Place the marker and the cursor on the steepest part of the curve 
recorded during inhalation (Figure 4-6 on page 75). Read the rate of 
change of volume (v2-v1) at the top of the Analysis window and 
divide this value by time (t2-t1). Calculate the average of the five 
calculated values and enter your data in the Journal.

 Figure 4-6: The integral of the spirometer signal recorded 
from a resting volunteer. The cursors are positioned on the 
steepest part of the inspiration slope.

¥ The maximum rate of air movement during inhalation is similar to the 
preceding bullet, except the markers are placed on the steepest portion of 
the exhalation curve. 

5 Use the markers to measure the tidal (TV) inspiratory reserve (IR) and 
expiratory reserve (ER) volumes and the vital capacity (VC) (Figure 4-7 
on page 76).
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 Figure 4-7: A recording in the Main window from a resting 
volunteer breathing through the spirometer (upper trace) and 
its integral (lower trace). The trace shows a normal 
breathing cycle (left) and then a forced inspiration and 
expiration (right); labels show tidal volume (TV), inspiratory 
reserve volume (IR), expiratory reserve volume (ER) and 
vital capacity (VC). Calculate mean values for each.

Data Analysis - 
Calculations

1 Use the mean duration of the breathing cycles to measure breathing rate:

Breathing rate =              60 breaths/minute

            mean duration (s)

2 Multiply the mean tidal volume (#2) by the breathing rate to calculate the 
volume of air passing in and out of the resting volunteer s lungs each 
minute.

Data Analysis - 
Tabulation

Tabulate your data as follows:

Air flow (mV/s)   Lung volumes (l)         Rate          Time/    Total air

 inhale   exhale TVIR     ER   VC   (breaths/m)   breath     flow /m

Resting:
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Exercise 2: 
Breathing 
Parameters 
from other 
Students

Aim: To measure breathing parameters in all students.

Procedure 1 Wash the spirometer head and wring dry. Be careful not to touch the 
membrane inside of the flow head.

2 Repeat Exercise #1, labeling each segment of file with the student s 
name.

3 Select Save in the File menu. 

4 Measure the lung volumes for each student.

Questions 1 Are the lung volumes the same in all students?

2 Combine class data to see whether there is any correlation between tidal 
volume or vital capacity and sex, smoking or apparent fitness?

Exercise 3: 
Breathing in the 
Volunteer 
Immediately 
after Exercise

Aim: To measure breathing parameters after exercise.

Procedure 1 Attach a clean spirometer head.

2 The volunteer should exercise sufficiently enough to elevate breathing 
rate, but with minimal class disruption. Running up and down flights of 
stairs is a good method.

3 The volunteer should immediately sit down, hold the spirometer by the 
grip and place the mouthpiece in the mouth. 

4 Quickly click Start, type after exercise,  and press Enter on the keyboard.

5 After about five breathing cycles, ask the volunteer to inhale as much as 
possible and then exhale as much as possible type comments and 
press Enter on the keyboard if possible.

6 Click Stop to halt recording. 

7 Select Save in the File menu.
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Data Analysis Repeat as for Exercise 1 and tabulate your data as follows:

Air flow (ml/s)    Lung volumes (l)            Rate         Time/     Total 
air   inhale   exhale TV IR ER   VC   (breaths/m)   breath     flow/m

Resting:

Exercise:

Questions: 1 Did tidal volume change after exercise?

2 Did exercise influence the time taken for each breathing cycle?

3 Did the rate of air flow during the inhaling phase increase with exercise  
how can you account for this?

4 Did the rate of air flow during the exhaling phase increase with exercise  
**/*+-how can you account for this?

5 Did the volume of air passing in and out of the resting volunteer s lungs 
each minute increase due to exercise? If so, was this due to an increase 
in the rate of breathing, the depth of breathing (tidal volume) or a combi-
nation of both factors?

6 Did exercise influence the vital capacity of the individual?

7 If the tidal volume changed due to exercise, can this be accounted for by 
changes in the TV, IR, the ER, or some combination of both?

Experiment 10: Breathing and Gravity

Overview Over the long term, the amount of oxygen (O2) taken up and 
carbon dioxide (CO2) discharged by the tissues is matched with the 
amount of O2 taken up and CO2 discharged at the lungs. Changes in 
the demands made by the body cause the respiratory control center 
in the medulla to change the depth and rate of breathing. This was 
seen in the last laboratory when the effect of exercise was examined. 
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The exchange of O2 and CO2 at the lungs relies upon diffusion 
between the air and the blood. Any change in the rate of diffusion 
could produce a change in breathing parameters. One factor that 
influences the rate of diffusion is surface area. All else being equal, 
an increase in the surface area will increase the rate of diffusion and 
thus decrease the rate and depth of breathing. This will be examined 
in this lab.

Gaseous exchange between the alveolar air and the blood takes 
place at the pulmonary capillaries. These thin-walled vessels are 
distensible and easily collapse. The diameter of the pulmonary capil-
laries is determined by the transmural pressure the pressure 
difference between the inside (blood pressure) and the outside 
(alveolar pressure) of the vessel. If the pressure in the alveoli is 
greater than the blood pressure the pulmonary capillaries will 
collapse and blood will not flow through them. Under these condi-
tions, while the diffusion gradients may be present for the exchange 
of O2 and CO2 between the air and the blood, the collapsed vessels 
will preclude any gaseous exchange. 

In this lab you will examine the effects of gravity on breathing, first 
by observing the effects on peripheral circulation in the finger, and 
then by measuring the different lung volumes during normal 
breathing in a resting volunteer who is standing and then lying down.

Equipment 
Required

PC computer

ETH-256 and National Instruments A/D Card

Spirometer flow head and plastic tubes

SP-100, spirometer unit with cable

Plethysmograph

Equipment 
Setup

1 Connect the ETH-256 unit to the A/D card   (described in Chapter 1).

2 Firmly push the two air flow tubes into the two outlets on the flow head. 

3 Firmly push the other ends of the two air flow tubes into the two outlets on 
the SP-100 spirometer unit.

4 Use the cable to connect the output on the spirometer unit to the input on 
channel two of the ETH-256 hardware (Figure Figure 4-8 on page 80).

5 Untangle the plethysmograph cable.

6 Place the plethysmograph on the volar surface (where the fingerprints are 
located) of the distal segment of a middle finger; wrap the Velcro to attach 
the unit firmly to the end of the finger.
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7 Push the DIN 8 plug on the other end of the cable into the socket labeled 
channel one (Figure 4-8 on page 80). 

 Figure 4-8: Attach the spirometer and plethysmograph to 
the ETH-256.

8 Set the controls on the ETH-256 as follows

Ch. 1: Plethysmograph Ch. 2: Spirometer pod

Gain x10 x1

High Pass DC DC

Low Pass 50Hz 50Hz

Start the 
Software

1 Click the (Windows) Start menu, move the cursor to Programs and then to 
the iWorx folder and select LabScribe. 

2 When the program opens, select Load from the Settings menu.   

3 When the dialog box appears, select Human and then click OK.

4 Click on the Settings menu again and select the Lung #2 settings file.

5 After a short time, LabScribe will appear on the computer screen with the 
Lung #2 settings.

Before Starting 1 The spirometer will monitor breathing from a volunteer. It is important that 
the volunteer is healthy and has no history of respiratory or cardiovascular 
problems.

2 The tubes on the flow head should always be in the upright position, to 
avoid problems with condensation.

3 Turbulent air flow through the flow head will produce a noisy signal.To 
avoid turbulent air flow, be sure that the flow head opening is inside of the 
mouth. Remember that air that enters or leaves through the nose is not 
counted in the volume calculation and will cause errors in the reading
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4 The spirometer will display flow on channel two. The software is set to 
integrate the data on channel two and display it as a volume on channel 
three. The LabScribe software will report volume in liters on channel three 
using a conversion factor of 150 mVsec/liter. If the calibration number 
written on the spirometer serial number tag is larger or smaller (by more 
than 10%) than 150mVsec/liter you may have to recalibrate channel 
three. Check to be sure that the software is set to integrate the flow data 
by moving the mouse to place the cursor over channel three, right click 
the mouse and check that the Integrate option is checked. If it is not 
checked, select it now. 

Exercise 1: The 
Effects of 
Gravity on 
Peripheral 
Circulation

Aim: To study the effects of gravity on blood circulation in the 
finger.

Procedure 1 The volunteer should sit quietly with their hands in their lap.

2 Click Start and record the finger pulse.

3 Click AutoScale in the channel one title area and see the rhythmic finger 
pulse signal get bigger. Type hands in lap  and press Enter on the 
keyboard.

4 The volunteer should then place both hands on their head; type hands on 
head  and press Enter on the keyboard.

5 The volunteer should then reach both hands as high as possible (don t 
stretch the cable); type hands high  and press Enter on the keyboard.

6 Click Stop to halt recording.

7 Select Save As in the File menu, type a meaningful name and save the 
file in an appropriate place on the hard drive. 

Data Analysis 1 Use the arrows at the bottom of the window to scroll to the beginning of 
the recording. 

2 Click the 2 cursor icon (Figure 4-9 on page 82), so that two blue vertical 
lines appear over the recording window.

3 Drag the cursors left and right to place them between the first five or so 
finger pulse signals.

4 Click the Analysis icon (Figure 4-9 on page 82) to open the Analysis 
window.
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 Figure 4-9: The LabScribe toolbar

5 Click to de-select channels two and three.

6 Click and drag the cursors left and right on channel one to place one on 
the baseline before the first signal and the second at the peak of the 
signal (Figure 4-10 on page 82). Read off the peak blood flow from the 
resting volunteer as the voltage difference (v2-v1). Right click the mouse 
and select to enter the title and then the data into the Journal label as 
data from volunteer with hands in lap.

7 Repeat with data obtained in the other two hand positions.

8 Click the Journal icon (Figure 4-9 on page 82) and label the average 
value for blood flow in the different hand positions.

 Figure 4-10: A recording from the plethysmograph in the 
Main window where the hands located in the volunteer s lap 
(left) were raised above the head (right).
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Questions 1 What happens to the size of the finger pulse when the hands are raised?

2 If the size of the finger pulse signal indicates blood pressure, what do you 
think happens to blood pressure in the fingers when the hands are raised 
over the head?

Exercise 2: 
Breathing when 
Standing (or 
sitting)

Aim: To study and measure various breathing parameters in an 
erect volunteer.

Equipment 
Setup

Disconnect the plethysmograph from the ETH-256 unit by removing 
the DIN8 plug from channel one.

Procedure 1 The volunteer should hold the spirometer head with the air flow tubes up. 
Breath normally this is difficult when you think about it! The volunteer 
should sit or stand quietly and become accustomed to breathing through 
the spirometer.

2 Click Start and record the rhythmic signal produced by the volunteer s 
breathing. Type standing (or sitting)  and press Enter on the keyboard.

Note: The LabScribe software does a zero calibration during the first second 
of recording. No air should be moving through the flow head during this time. 

3 After five breathing cycles ask the volunteer to inhale as much as possible 
(type inhale  and press Enter on the keyboard) and then exhale as much 
as possible (type exhale  and press Enter on the keyboard).

4 Click Stop to halt recording.

5 Select Save in the File menu. 

Data Analysis - 
Measurements

For each of the five breathing cycles (prior to the forced inhale and 
exhale) use the two cursors to measure:

The Tidal Volume

1 Use the arrows at the bottom of the window to scroll to the beginning of 
this section of the recording. 

2 Click the 2 cursor icon (Figure 4-9 on page 82), so that two blue vertical 
lines appear over the recording window.

3 Drag the cursors left and right to place them between the first two 
breathing cycles.
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4 Click the Analysis icon (Figure 4-9 on page 82) to open the Analysis 
window.

5 Click to de-select channels one and four.

6 Click and drag the cursors left and right on channel three to place one on 
the trough of the signal and the other on the peak (Figure 4-11 on page 
84). Read off the tidal volume from channel three in the resting volunteer 
as the voltage difference (v2-v1). Right click the mouse and select to enter 
the title and then the data into the Journal.

7 Scroll through your record in the Analysis window and repeat the above 
measurement for all breathing cycles.

8 Click the Journal icon (Figure 4-9 on page 82), label your data as a 
recording of tidal volume from a resting individual and calculate the 
average tidal volume value. 

 Figure 4-11: The spirometer signal (upper trace) and its 
integral (lower trace) recorded from a resting volunteer and 
displayed in the Main window; an upward deflection of the 
upper trace represents inspiration. The cursors are 
positioned on the peak and trough of the integrated signal to 
measure the tidal volume (0.015 volts in this example).

The (time) duration of each of the five breathing cycles.

1 Proceed as above, except the time (t2-t1) between adjacent peaks Figure 
4-12 on page 85.
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2 Click the Journal icon (Figure 4-9 on page 82), label your data as a 
recording of tidal volume from a resting individual and calculate the 
average tidal volume value.

 Figure 4-12: The integral of the spirometer signal recorded 
from a resting volunteer and displayed in the Main window. 
The cursors are positioned on the peaks of successive signals 
to measure the time interval.

Air Movement

1 Use the arrows at the bottom of the window to scroll to the beginning of 
the recording. 

2 Click and drag the cursors left and right on channel three to place them on 
the steepest portion of the inhalation curve (Figure 4-13 on page 85).   
Read off the peak rate of air flow during exhalation in the resting volunteer 
as the voltage difference (v2-v1). Right click the mouse and select to 
enter the title and then the data into the Journal.

3 Scroll through your record in the Analysis window and repeat the above 
measurement for all breathing cycles.

4 Click the Journal icon (Figure 4-9 on page 82), label your data as a 
recording of tidal volume from a resting individual and calculate the 
average tidal volume value. 

 Figure 4-13: The integral of the spirometer signal recorded 
from a resting volunteer. 

The cursors are positioned on the steepest part of the inspiration 
slope.
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Data Analysis - 
Calculations

1 Use the mean duration of the breathing cycles to measure breathing rate:

Breathing rate =              60 breaths/minute

            mean duration (s)

2 Multiply the mean tidal volume (#2) by the breathing rate (#1) to calculate 
the volume of air passing in and out of the resting volunteer s lungs each 
minute.

 Figure 4-14: A recording in the Main window from a resting 
volunteer breathing through the spirometer (upper trace) and 
its integral (lower trace). The trace shows a normal 
breathing cycle (left) and then a forced inspiration and 
expiration (right); labels show tidal volume (TV), inspiratory 
reserve volume (IR), expiratory reserve volume (ER) and 
vital capacity (VC). Calculate mean values for each.

Data Analysis -
Tabulation

Tabulate your data as follows:

 Air flow (ml/s)   Lung volumes (l)         Rate          Time/    Total air

 inhale   exhale TVIR     ER   VC   (breaths/m)   breath     flow/m

Erect:
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Exercise 3: 
Breathing when 
Lying Down 
(face up)

Aim: To study and measure various breathing parameters in a 
volunteer who is lying down.

Procedure 1 The volunteer should lie down on their back and relax.

2 As before, the volunteer should not be disturbed and should be relaxed 
and accustomed to breathing through the spirometer.

3 Click Start, type lying down  and press Enter on the keyboard.

4 After about five breathing cycles ask the volunteer to inhale as much as 
possible and then exhale as much as possible type comments and 
press Enter on the keyboard.

5 Click Stop to halt recording.

6 Select Save in the File menu. 

Data Analysis Repeat as for Exercise 2 and tabulate your data as follows:

Air flow (ml/s)   Lung volumes (l)         Rate          Time/    Total air

 inhale   exhale TVIR     ER   VC   (breaths/m)   breath     flow/m

Erect:

Lying

Questions 1 What effect does lying down have on the total amount of air breathed into 
the lungs/minute?

2 What effect does lying down have on the various lung volume?

3 Examining tidal volume, what is the effect of lying down?

4 From your analysis of data on finger pulse, what is the effect of raising 
your hand on blood pressure?

5 With this answer in mind, in the standing individual would the blood 
pressure be the same in the pulmonary capillaries at the base of the lung 
and the apex (top) of the lung? Which would have the lower blood 
pressure?

6 With this answer in mind, if you assume that the lower the blood pressure 
the more likely those pulmonary capillaries are to be collapsed, where in 
the lung would you expect there to collapsed capillaries at the base or at 
the apex?
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7 If some capillaries are collapsed, what would be the functional effect of 
this on the surface area for the diffusion of O2 and CO2?

8 Now, in the individual who is lying down. Would you expect such a 
dramatic influence on the blood pressure in this position?

9 If the blood pressure is about the same in all pulmonary capillaries would 
you expect the capillaries to be collapsed?

10 If all pulmonary capillaries are open when lying down, what would be the 
functional effect of this on the surface area for the diffusion of O2 and 
CO2?

11 Considering the two body positions, if the demands for O2 and CO2 are 
the same, what should be the effect on tidal volume and breathing rate? 
Do you see this?

12 Can you predict any differences in the levels of O2 and CO2 in the 
exhaled air of people standing and lying down?

Experiment 11: Factors that Effect Breathing 
Patterns

Overview The respiratory control center in the medulla is responsible for 
matching the amount of O2 used by, and CO2 produced at, the 
tissues with the amount of O2 taken up and CO2 discharged at the 
lungs. Lung ventilation can be influenced by many factors, including 
emotion, speech, disease, and the body s position relative to gravity. 
This latter factor was the focus of the last exercise. In this lab you 
will examine other factors that influence breathing as well as the 
effect of breathing on cardiac function.

Equipment 
Required

PC computer

ETH-256 and National Instruments A/D Card

Disposable spirometer flow head and plastic tubes

SP-100DH, spirometer unit with cable

Plethysmograph

Needle and thread
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Equipment 
Setup

1 Connect the ETH-256 unit to the A/D card   (described in Chapter 1).

2 Firmly push the two air flow tubes into the two outlets on the flow head. 

3 Firmly push the other ends of the two air flow tubes into the two outlets on 
the SP-100 spirometer unit.

4 Use the cable to connect the output on the spirometer unit to the input on 
channel two of the ETH-256 (Figure 4-15 on page 89).

 Figure 4-15: Attach the spirometer and Plethysmograph to 
the ETH -256 unit.

5 Set the controls on the ETH-256 as follows: 

Ch. 1: Plethysmograph Ch. 2: Spirometer Pod

Gain x10 x1

High Pass DC DC

Low Pass 50Hz 50Hz

Start the 
Software

1 Click the (Windows) Start menu, move the cursor to Programs and then to 
the iWorx folder and select LabScribe. 

2 When the program opens, select Load from the Settings menu.   

3 When the dialog box appears, select Human and then click OK.

4 Click on the Settings menu again and select the Lung #3 settings file.

5 After a short time, LabScribe will appear on the computer screen with the 
Lung #3 settings.
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Before Starting 1 The spirometer will monitor breathing from a volunteer. It is important that 
the volunteer is healthy and has no history of respiratory or cardiovascular 
problems.

2 The tubes on the flow head should always be in the upright position, to 
avoid problems with condensation.

3 Turbulent air flow through the flow head will produce a noisy signal.To 
avoid turbulent air flow, be sure that the flow head opening is inside of the 
mouth. Remember that air that enters or leaves through the nose is not 
counted in the volume calculation and will cause errors in the reading

4 The spirometer will display air flow on channel two. The software is set to 
integrate the data you are recording on channel two and display it as a 
volume on channel three. The LabScribe software will report volume in 
liters on channel three using a conversion factor of 150 mVsec/liter. If the 
calibration number written on the spirometer serial number tag is larger or 
smaller (by more than 10%) than 150mVsec/liter you may have to recali-
brate channel three. Check to be sure that the software is set to integrate 
the flow data by moving the mouse to place the cursor over channel three, 
right click the mouse and check that the Integrate option is checked. If it is 
not checked, select it now. 

Exercise 1: 
Coughing.

Aim: To study the any changes in breathing patterns due to 
coughing.

Procedure 1 The volunteer should hold the spirometer head with the air flow tubes up. 
Breath normally this is difficult when you think about it! The volunteer 
should sit quietly and become accustomed to breathing through the 
spirometer.

2 Click Start and record the rhythmic signal produced by the volunteer s 
breathing. Type resting  and press Enter on the keyboard.

3 After about five breathing cycles ask the volunteer to cough (type cough  
and press Enter on the keyboard). 

4 Click Stop to halt recording.

5 Select Save As in the File menu, type a meaningful name and save the 
file in an appropriate place on the hard drive. 

Data Analysis - 
Measurements

Tidal Volume

1 Use the arrows at the bottom of the window to scroll to the beginning of 
the recording. 

2 Click the 2 cursor icon (Figure 4-16 on page 91), so that two blue vertical 
lines appear over the recording window.
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3 Drag the cursors left and right to place them between the first two 
breathing cycles.

4 Click the Analysis icon (Figure 4-16 on page 91) to open the Analysis 
window.

 Figure 4-16: The LabScribe toolbar

5 Click to de-select channels one and two.

6 Click and drag the cursors left and right on channel three to place one on 
the trough of the signal and the other on the peak (Figure 4-17 on page 
92). Read off the tidal volume from channel three in the resting volunteer 
as the voltage difference (v2-v1). Right click the mouse and select to enter 
the title and then the data into the Journal.

7 Scroll through your record in the Analysis window and repeat the above 
measurement for all breathing cycles.

8 Click the Journal icon (Figure 4-16 on page 91), label your data as a 
recording of tidal volume from a resting individual and calculate the 
average tidal volume value.
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 Figure 4-17: The spirometer signal (upper trace) and its 
integral (lower trace) recorded from a resting volunteer and 
displayed in the Main window; an upward deflection of the 
upper trace represents inspiration. The cursors are 
positioned on the peak and trough of the integrated signal to 
measure the tidal volume 

Air Movement

1 Use the arrows at the bottom of the window to scroll to the beginning of 
the recording. 

2 Click and drag the cursors left and right on channel three to place one on 
the baseline and the other on the peak of the signal (Figure 4-18 on page 
93).   Read off the peak rate of air flow during exhalation in the resting 
volunteer as the voltage difference (v2-v1). Right click the mouse and 
select to enter the title and then the data into the Journal.

3 Scroll through your record in the Analysis window and repeat the above 
measurement for all breathing cycles.

4 Repeat with the air flow seen during the cough.

5 Repeat these measurements for inhalation, using the downward deflec-
tions in channel three.
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 Figure 4-18: The integral of the spirometer signal recorded 
from a resting volunteer. The cursors are positioned on the 
steepest part of the inspiration slope.

Questions 1 What phase of the breathing cycle (exhale or inhale) immediately 
precedes the cough?

2 Does the tidal volume change during the cough?

3 If so, look at your data and determine if the tidal volume changed by 
changing the amount of air inhaled, exhaled, or some combination of 
both?

4 Compare the speed of air flow during a normal exhale and the cough. 
Which is faster?

Exercise 2: 
Concentration

Aim: To study any changes in breathing patterns due to concen-
tration.

Procedure 1 Push the tip of a needle firmly into a piece of wax or an eraser. Place the 
needle close to the volunteer perhaps on the bench top or the top of the 
computer monitor.

2 The volunteer should hold the spirometer in one hand and a piece of 
thread in the other. As before, the volunteer should not be disturbed and 
should be relaxed and accustomed to breathing through the spirometer.

3 Click Start and record the rhythmic signal produced by the volunteer s 
breathing. Type resting  and press Enter on the keyboard.

Note: The LabScribe software does a zero calibration during the first second 
of recording. No air should be moving through the flow head during this time. 

4 After about five breathing cycles ask the volunteer to try to thread the 
needle type concentration  and press Enter on the keyboard; type 
through  and press Enter on the keyboard when the needle has been 

threaded. 

5 Click Stop to halt recording.
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6 Select Save in the File menu. 

Data Analysis As described above, use the two cursors to measure:

¥ The tidal volume: the amplitude of each breathing cycle (Figure 4-17 on 
page 92) from channel two before, during and after threading the needle.

¥ The rate of air movement/second during inhalation before and after 
threading the needle (Figure 4-19 on page 94).

¥ The rate of air movement/second during exhalation before and while 
threading the needle (Figure 4-18 on page 93).

 Figure 4-19: The integral of the spirometer signal recorded 
from a resting volunteer and displayed in the Main window. 
The cursors are positioned on the peaks of successive signals 
to measure the time interval.

¥ The (time) duration of each of the five breathing cycles measure the 
duration from peak to peak in the air flow record (channel two) as shown in 
Figure 4-19 on page 94.

Questions 1 Which breathing parameters change during the time when fine motor 
control is required?

2 Can you explain your observations?

Exercise 3: 
Sitting Up

Aim: To study any changes in breathing patterns when sitting up.

Procedure 1 The volunteer should lie down on their back and relax.

2 As before, the volunteer should not be disturbed and should be relaxed 
and accustomed to breathing through the spirometer. 

Note: The LabScribe software does a zero calibration during the first second 
of recording. No air should be moving through the flow head during this time. 

3 Click Start, type lying down  and press Enter on the keyboard.
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4 Allow the volunteer to breathe about five complete cycles, type sit up 
when inhaling  and press Enter on the keyboard as the volunteer sits up 
during the inhaling phase. 

5 The volunteer should lie down on their back and relax. Repeat the above, 
but make the request to sit up the exhaling phase of the breathing cycle.

6 Click Stop to halt recording.

7 Select Save in the File menu. 

Data Analysis Do the breathing patterns change immediately before and during 
the time when the volunteer is sitting up?

Exercise 4: 
Increasing the 
Length of the 
Airways

Aim: To study any changes in breathing patterns when the 
volunteer breathes through a plastic tube.

Procedure 1 The volunteer should sit in a chair. As before, the volunteer should not be 
disturbed and should be relaxed and accustomed to breathing through the 
spirometer.

2 Click Start, type resting  and press Enter on the keyboard. Allow the 
volunteer to breathe about five complete cycles. 

Note: The LabScribe software does a zero calibration during the first second 
of recording. No air should be moving through the flow head during this time. 

3 Place a length of plastic tubing on the spirometer and record about 10 
breathing cycles; type breathing through a tube , and press Enter on the 
keyboard.

4 Click Stop to halt recording.

5 Select Save in the File menu. 

Data Analysis Use the two cursors in the Analysis window to measure the tidal 
volume (Figure 4-17 on page 92), the maximum rate of inhalation and 
exhalation (Figure 4-18 on page 93), and the frequency of breathing 
(Figure 4-19 on page 94) before and after the tube is attached. Type 
labels and enter your data into the Journal. Do these parameters 
change?
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Questions 1 Do you think the oxygen requirements of the volunteer changed dramati-
cally when the tube was attached?

2 Where does gaseous exchange take place in the lungs?

3 Does gaseous exchange occur across the walls of the airways (trachea, 
bronchi and bronchioles)?

4 If you increased the volume of the airways to match the resting tidal 
volume, would fresh air ever reach the alveoli?

5 Why does the tidal volume increase when the volunteer breathes through 
a tube?

Exercise 5: 
Breathing and 
Cardiac 
Function

Aim: To study changes in heart rate during breathing.

Equipment Setup 1 Untangle the plethysmograph cable.

2 Place the plethysmograph on the volar surface (where the fingerprints are 
located) of the distal segment of a middle finger; wrap the Velcro to attach 
the unit firmly to the end of the finger.

3 Push the DIN8 plug on the other end of the cable into the socket labeled 
channel one. 

Procedure 1 The volunteer should sit quietly and, as before, should not be disturbed 
and should be relaxed and accustomed to breathing through the 
spirometer. The volunteer should try to breathe slowly and deeply.

2 Click Start and record breathing and the finger pulse.

Note: The LabScribe software does a zero calibration during the first second 
of recording. No air should be moving through the flow head during this time. 

3 Click AutoScale in the channel one title area and see the rhythmic finger 
pulse signal get bigger. 

4 Type deep breathing,  ask the volunteer to breathe slowly and deeply, 
and press Enter on the keyboard; record about 10 complete breathing 
cycles.

5 Click Stop to halt recording.

6 Select Save in the File menu. 
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Data Analysis Your data may look like Figure 4-20 on page 97.

 Figure 4-20: The integral of the spirometer signal (upper 
trace) and the finger pulse (lower trace) recorded and 
displayed in the Main window during slow, deep breathing.

1 Look at your data. Does the heart rate (as shown by the finger pulse) 
appear to change during the breathing cycle?

2 Quantify this by using the two cursors in the Analysis window to measure 
the time interval between peaks in the finger pulse record (Figure 4-20 on 
page 97). Make measurements during different phases of the breathing 
cycle. 

Try the following experiments to further examine the link between 
breathing and heart rate:

¥ To examine the effects of gravity, repeat the deep breathing experiment 
with the subject lying on their back. Are the effects on heart rate as 
pronounced?

¥ Have the volunteer breathe out and then go through the motions to breathe 
in but close the mouth and nose i.e. lower the diaphragm and raise the ribs 
to inflate the thorax, but do not allow any air into the lungs. This will produce 
a negative pressure in the thoracic cavity. What is the effect on heart rate?

¥ Have the volunteer breathe in and then hold their breath as long as they 
can (this is the Valsalva maneuver) record breathing and finger pulse 
during apnea (hold breath) and during recovery. 
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Questions 1 Where is the heart in relation to the lungs?

2 If there is a negative pressure in the lungs, would the heart be subjected 
to the same pressure changes?

3 Would a negative pressure outside the capillaries functionally increase the 
transmural pressure i.e. the pressure difference between the inside of a 
blood vessel and the outside?

4 Would this create an increase in the blood pressure in the veins of the 
thorax i.e. those leading to the heart?

5 What would be the effect of a negative thoracic pressure on the rate of 
blood return to the heart?

6 What would be the effect of negative pressure on the heart rate? Do you 
see this?

7 Does gravity play a role in heart rate fluctuation during breathing? 

8 How would a decline in blood O2 levels (and/or an increase in blood CO2 
levels) influence heart rate as seen when the volunteer held their 
breath?
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Appendices

The Transducers Included with the HK/256NI 
Human Physiology Teaching Kit

Your HK/256NI Human Physiology Teaching Kit is supplied with 
four transducers that enable you to perform the labs in the main 
section of the manual. Additional hardware, such as GSR-100 
Galvanic Skin Response Meter and Force/Displacement Trans-
ducers, are also available. Detailed background on the transducers 
provided with your kit, as well as on the ETH-256 Combination 
Bridge/Bioamplifier is included in this Appendix. All of the trans-
ducers will connect directly into either the ETH-256 or the BNC 
connectors on channels one and two on the iWorx unit.

Included Items:

¥ Event Marker (Appendix A)

¥ Plethysmograph (Appendix B)

¥ Hand Dynamometer (Appendix C)

¥ Flow Spirometer (Appendix D)

¥ ETH-256 Combination Bridge/Bioamplifier (Appendix E)

Appendix A: The Event Marker

 Figure A-1
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The event marker is a simple electronic marking device. It connects 
to either of the 8 pin DIN Input Connectors on the ETH-256 Combi-
nation Bridge/Bioamplifier. Pressing the button on the top of the 
cylinder will send a +4V signal to the input of the channel to which 
the clicker is connected. Releasing the button will return the voltage 
to zero.

Appendix B: The Plethysmograph (pulse 
transducer)

To use the plethysmograph, simply connect it to either of the BNC 
fittings on the front panel of the ETH-256. The signal output of this 
transducer, when used to pick up your pulse, should be between 50 
and 150 mV (this will vary for each individual, and with environmental 
conditions such as temperature). Adjust your gain accordingly. 
When attached to your thumb or forefinger with the supplied Velcro 
strap, it can be used to visualize a volume pulse waveform.

As its alternative name (pulse transducer) implies, the plethysmo-
graph displays a representation of your pulse, but it is a generally 
useful accelerometer. The transducer is based on a piezoelectric 
crystal. Piezoelectric materials develop voltage while their shape is 
being changed. For example, if you place a weight on such a crystal, 
while the weight and the force of gravity are compressing the crystal, 
it gives off a voltage proportional to the acceleration of its outer edge 
away from the deforming force. When the final compressed  state is 
reached, the outer edge of the crystal is no longer moving and no 
voltage is evident. It stays in this no output state until the weight is 
removed and the crystal expands. Again, voltage proportional to 
acceleration is produced, but this time the polarity of the voltage is 
the opposite of that produced during compression, since the acceler-
ation is in the opposite direction.

Try this with your plethysmograph: while recording, gently squeeze 
it between your thumb and forefinger, hold it for a second and then 
release it. Note that the positive spike displayed in the window when 
you squeeze and the negative spike when you release.

Warning: Squeezing too hard can collapse the transducer surface.

The plethysmograph is an AC-coupled device. That means its 
output will always return to zero after the pressure event has been 
recorded. The AC nature of the plethysmograph means that you never 
need to adjust the zero position of the transducer, and that you can 
increase the gain of the recording amplifier as high as you like to 
Appendix 100



        
record even the smallest events. Conversely, you cannot measure 
steady state forces. The plethysmograph cannot be used as a force 
transducer.

Appendix C: The Hand Dynamometer
The hand dynamometer is an air-filled bulb with a pressure sensor 

sealed inside which connects to either of the 8-pin DIN Input 
Connectors on the ETH-256 Combination Bridge/Bioamplifier. As you 
grip the bulb, the pressure inside climbs, causing the sensor to put 
out more voltage.

Because a certain amount of pressure exists in the bulb when it is 
not being squeezed, the baseline will not be zero Volts. Most sensors 
will display a 60-70 millivolt offset.

Using the Hand 
Dynamometer

Plug the cable extending from the bulb into either of the 8-pin DIN 
Input Connectors on the ETH-256 Combination Bridge/Bioamplifier. 
Open the input amplifier for the channel to which you are connected 
and observe the voltage. Make sure that the 50Hz filter and both 
positive and negative check boxes are checked as in the diagram 
below.

 Figure A-2

The sensor will produce approximately 3mV per kilogram of applied 
force. In light of the offset and the output sensitivity, the scale should 
be set to about 200mV. Use the set scale  option (in the unlabeled 
pull-down menu to the right of the Y-axis in the input amplifier 
window) to view only the 50-200mV area of the screen.
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 Figure A-3

If your transducer has a higher or lower baseline, you will need to 
set the scale accordingly (e.g., if your baseline is 80mV instead of 
50mV, you should set the scale to display only the 80-20 mV region).

 Figure A-4

You can use the units conversion option (the Units...  button in the 
Input Amplifier window, or in the channel menu) to convert from milli-
volts to percent. For example, you could assign the baseline voltage 
of the dynamometer to 0%, and the voltage obtained when you grip it 
as hard as you can to 100%, as shown below.
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 Figure A-5

Appendix D: The Flow Spirometer
The flow spirometer measures volumes and flows from normal 

breathing. To use the spirometer, connect it to either of the Input 
Connectors on the ETH-256 Combination Bridge/Bioamplifier.

What It Is The Flow spirometer provided with the Human Physiology Teaching 
Kit consists of three parts:

1 An electronic sensor that functions as a handle

2 A disposable or reusable flowhead

3 Polyethylene tubing used to attach the flowhead to the sensor

How It Works The spirometer box contains a differential air pressure sensor. It 
measures the difference in air pressure between the front and rear 
sides of the mesh screen in the flow head supplied in the kit. When 
the spirometer is assembled, blowing into the mouthpiece will 
produce a measurable pressure difference across the screen in the 
flowhead. The sensor will produce a voltage, which is directly propor-
tional to the pressure. It is this voltage that the iWorx unit records.

Assembling the 
Flow 
Spirometer

Push the two plastic tubes onto the inlet ports of the sensor. A 
small amount of cotton can be placed in each tube to guard against 
condensation, but is not necessary. Press a flowhead onto the other 
end of the two plastic tubes. 
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Using the Flow 
Spirometer

Plug the spirometer cable into either of the inputs on the rear of the 
ETH-256. Open the input amplifier for the channel that you are 
connected to and observe the voltage. Press the red zero button on 
the back of the spirometer box. Adjust the output completely to zero 
using the zero offset knob on the front panel of the ETH-256.

 Figure A-6

Be sure to fix the spirometer box so that it cannot move around 
during the measurement. The internal differential sensor is 
measuring pressure in tenths of mm of water, any movement will 
produce an artifact that the iWorx unit will read as a volume. Secure 
the spirometer box by clamping it in a ring stand or taping it down to 
the lab bench. Be sure to allow about 7-10 minutes after you plug the 
spirometer in to warm up. If you blow into the mouthpiece you should 
see the trace move up or down. The value in Volts is directly propor-
tional to flow in liters per minute.

How Do We Get 
Volumes?

If we know the flow rate and measure the time, we can calculate the 
volume. For example, if the flow rate is one liter per second and the 
flow continues for 10 seconds, the total volume is 10 liters. If the flow 
rate is constant we can do the volume calculation in our heads. But 
as you can see from testing the flowhead, the flow rates are 
constantly changing. You can obtain the volume if the computer 
calculates the area under the flow curve. In this operation, called 
integration, the computer continuously measures and reports the 
area between the flow line and zero. This is why it is important to 
have adjusted the zero correctly, as described above.

How Do We Get 
Correct Units?

When correctly adjusted, the spirometer will produce about 145mV 
per liter per minute of flow. This linear relationship will hold true up to 
about 250 liters per minute, which is fine for most non-exercise 
testing. Enter the data in the following figure into the Units 
Conversion  dialog box as shown below. To get the display to read in 
liters per minute, use the Define Units item under the Units pull-down 
menu in the Units Conversion Dialog window, as shown below. You 
are now ready to proceed.
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 Figure A-7

Appendix E: The ETH-256 Combination Bridge/
Bioamplifier

Overview The ETH-256 is a combination transducer and biopotential 
amplifier. Its controls, filter settings and gains were selected with 
these applications in mind, thereby making it well suited for the 
student physiology and the research lab. The ETH-256 is powered by 
a wall transformer (12 Volts AC 1000mA). It connects to the ETH-256 
with a standard 3.0mm phono plug through a receptacle on the rear 
panel. The ETH-256 uses an optically isolated pod and patient cable 
for recording biopotentials (ECG, EMG,EEG) from human subjects. 

Note: Under no circumstances should human subjects be connected to the 
ETH-256 without employing this pod and cable.

Using the biopotential pod and cable, the ETH-256 can allow 
display of any of the 12 ECG lead positions. You can change which 
leads are displayed by manually changing connectors.
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 Figure A-8

Topography

Front Panels 
and Controls

The ETH-256 is divided into two identical functional units (Figure A-
8 on page 106), capable of making low noise AC coupled recordings 
of bioelectric potentials or DC coupled transducer recordings. Three 
push-buttons and one knob control each channel, the functions of 
which are described below. In addition, the input connectors for each 
channel can be found on the front panel.

High-Pass Filter The high-pass filter has four positions. Each time the button is 
pushed it advances in step-wise fashion to the next position. The 
position DC couples the input and is used for measuring from 
weatstone bridge-style transducers or other ground-referenced 
sensors requiring impedance conversion, such as pH electrodes or 
Ion Selective Electrodes (ISEs). There are three high pass filter 
settings, 0.03, 0.3 and 3Hz, which are used for ECG, EEG and EMG, 
respectively. The higher the value of the AC coupling filter, the more 
signal contributions from body movement or breathing are removed 
and the more stable the baseline becomes. 

Input Offset The amplifier will output a baseline signal in either bridge (DC) or 
bio (0.03, 0.3 and 3Hz) mode. This signal level can be moved up 
(positively) or down (negatively) by using the input offset knob. This 
control is of greatest use in bridge mode where adjustments to zero  
the output of a transducer or maximize the use of the screen or paper 
display area are required. 

Gain Each channel of the ETH-256 has independently adjustable gain. 
This allows very small signals to be amplified before presentation to 
the display device. The gain control allows you to select among eight 
preset multipliers; x1, x5, x10, x50, x100, x500, x1k and x5K.
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Low-Pass Filter 
(Hz)

The low-pass filter control sets the upper limit of frequencies 
measurable by the ETH-256. The 10K setting offers a maximum 
frequency response of about 10kHz. Other settings may be chosen to 
limit noise. For example, the 50Hz filter removes all signals above 
50Hz. This, of course, includes powerline noise, the most common 
source of electrical interference. For very slow signals such as output 
from force or pressure transducers, the 5Hz setting will provide the 
quietest recording.

Input The input connectors are either BNC for single-ended devices or 
DIN 8 for transducers, including the isolated biopotential recording 
pod.

 Figure A-9

Rear Panel and 
Connectors

The BNC output connectors for the ETH-256 are located on the 
rear panel. It can be cabled to your recorder or data analysis system 
using a common BNC-to-BNC cable. In addition to the output 
connectors the rear panel includes the power transformer input and 
the power switch.

Operation in Bridge Mode

Input The ETH-256 input connector is a standard eight pin DIN type 
located on the rear panel of the device. This provides rapid and 
reliable connection of transducers to the amplifier. The DIN mating 
component is a male eight pin DIN available from Preh (p/n 71408). 
The wiring of this connector is illustrated in Figure A-10 on page 108. 
A list of wiring schemes for common transducer types is found in the 
Appendix.
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 Figure A-10

Offset To adjust transducer offset over the full input range, use the 10-turn 
potentiometers mounted on the front panel. This allows precise 
control of the baseline position while still allowing substantial trans-
ducer offsets to be nulled.

Operation Transducers are connected to the input of the ETH-256 by means 
of a standard eight-pin DIN type connector. This connects the trans-
ducer to the –5V excitation, the positive and negative inputs of the 
differential amplifier and to the circuit ground.

Once the transducer has been correctly wired to the male eight-pin 
DIN connector, it is attached to an input channel on the ETH-256. 
The output of the transducer can now be viewed (at the selected 
gain) from the output BNC connector on the rear panel. Adjust offset 
as necessary.

Sample procedure for use of strain gauge type transducers 
with the ETH-256:

¥ After the transducer has been correctly fitted with an eight-pin DIN 
connector and attached to the appropriate input socket on the amplifier, 
connect the output BNC on the ETH-256 to the input of your recording 
device. 

¥ Set the ETH-256 gain to x1 and the filter to 5Hz.

¥ Observe the output of the ETH-256 on your recording device. Confirm that 
the baseline position can be affected by turning the input offset knob for this 
channel. Adjust the baseline to zero Volts.
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¥ If you cannot see the baseline move when you turn the input offset knob, 
try increasing the gain. A word about increasing gain  it s possible that your 
recorder will also amplify and/or position a signal. To avoid confusion, use 
only one set of controls to adjust gain or offset once the signal is positioned.

¥ Continue to increase the gain until you can easily position the line with the 
input offset control. If you cannot see a signal on your recorder or if the signal 
is pegged  all the way to the top or bottom of the recorder range, disconnect 
the transducer immediately and refer to the troubleshooting section of this 
manual.

¥ Now that you have your signal positioned, deflect your transducer by an 
amount appropriate to your experiment. For example, if you have connected 
a blood pressure transducer, apply approximately 250mmHg, or if you have 
connected a force transducer, hang a weight from it which is approximately 
equal to the maximum force you expect to see.

¥ Does the trace go off the screen or paper? If so, reduce the gain. If the 
deflection on the screen appears small (less than 20% of the full screen or 
paper), increase the gain. Your ETH/transducer is now ready to calibrate. 
Refer to the manual that came with your recorder for the best procedure to 
accomplish this. 

Amplification with no excitation voltage:

The high input impedance of the ETH-256 in bridge mode makes it 
useful for transducer types other than resistive bridges.   Piezo-
electric, pH or any device with a signal output less than –5V can be 
applied to the inputs in differential and single ended modes. Be 
careful to shield the cable and source when using high impedance 
devices. 

Sample procedure for use of a pH sensor with ETH-256:

¥ Set the ETH-256 gain switch to x1 and the filter setting to 50Hz. Put the 
electrode in pH 7.0 buffer. Observe the output of the ETH-256 on your 
recording device. Use the input offset to adjust the output to zero. Use a pH 
10 buffer to do the second measurement. Select a gain on the ETH-256 that 
allows the deflection from zero produced by the change of buffer to be seen. 
Refer to the manual that came with your recorder for the best procedure to 
accomplish this. 

Operation in Bio Mode
With either the 0.03, 0.3 or 3 Hz High Pass Filter LED illuminated, 

the amplifier is ready to record biopotentials. Any of these settings 
AC couples the input. AC coupling selectively removes the DC 
component of signals you are trying to record. For example, when 
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recording ECG, the surface electrodes provided will generate 
relatively small galvanic (steady state) potential between them when 
placed on the skin. This potential, while small, is many times the 
amplitude of the ECG signal you are attempting to record. In DC-
coupled mode, gain applied to the ECG component of the signal must 
also be applied to the galvanic potential. In most cases a gain large 
enough to see the ECG in DC mode will saturate the amplifier.

AC coupling the input selectively removes the galvanic potential 
and leaves just the ECG. You can now use all the gain required. In 
addition to DC signals, the 0.03, 0.3 or 3Hz filters will remove slowly 
moving AC signals as well (artifact due to breathing or movement).

Control/Setup Advance the high pass selection so that the 0.3Hz LED is illumi-
nated and set the gain to x10. As with the bridge mode, it is a good 
idea to use only one set of controls to adjust the gain or offset. Select 
the 150Hz low pass filter if you are recording ECG or 1kHz if you are 
recording EMG.

Isolated Pod 
and Patient 
Cable

The ETH-256 comes with a 3-lead isolated pod and patient cable. 
This cable may be used on either input. The cable contains a x50 
amplifier and an optically isolated output stage. When connected to 
the ETH-256, the gains set on the front panel are, therefore, multi-
plied by 50. 

Connecting the 
Leads

Attach surface electrodes to the subject. These leads should have 
a snap connector to be used with the supplied cables.

Operation With the settings above, you should now see the trace slowly 
approach zero. This can take 10 to 15 seconds if the amplifier has 
been open circuited for any length of time, so be patient and let the 
trace settle before you attempt to adjust offset. If the trace is noisy or 
wanders, see the troubleshooting section of this manual. Assuming 
the trace is stable and quiet, increase the gain until you can see an 
acceptable signal. When used with the isolated pod, a gain of x10 set 
on the front panel will produce an electrocardiogram of between .5 
and 1 Volt.

The ETH-256 can be used to record signals such as ECG, EMG, 
EOG and EEG. It can also be used to measure from muscle and 
nerve directly. It is ideally suited for frog sciatic experiments or 
measurements in vivo with hook electrodes.
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Sample procedure for recording ECG:

Plug the supplied isolated pod and cable into the input socket for 
channel one. Using an alcohol prep or alcohol soaked cotton ball, 
lightly abrade the skin on the underside of each forearm and on the 
back of the calf near the ankle. After the skin dries, attach a 
disposable, adhesive-backed electrode to each of the sites. Connect 
the brown lead (ground) to the leg. Connect the white lead (positive 
channel one) to the left arm and finally the green lead (negative 
channel one) to the right arm. The output now available on channel 
one is the ECG Lead 1." Increase the gain until the form of the ECG 
can be clearly seen. Other ECG lead configurations are given at the 
end of this chapter.

Sample procedure for recording EMG:

In this experiment, we will be recording an EMG signal from the 
anterior forearm muscles. Using a felt tip pen, mark the skin of your 
subject on the anterior forearm two-thirds of the distance from the 
wrist to the antecubital space (bend of the elbow). Then, have him/
her flex his/her fingers tightly into a fist and mark a spot about two 
centimeters above the crease of the wrist where you see the 
appearance of tendons. Lastly, place a mark halfway and slightly off-
line between the other two marks. Using an alcohol soaked cotton 
ball, lightly abrade the skin at each of these sites. After the arm 
dries, attach a disposable, adhesive-backed electrode to each of the 
sites. According to Figure A-11 on page 111, connect the leads from 
the ETH-256 biopotential pod to the forearm electrodes. 

 Figure A-11
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Have your subject sit quietly in a chair with their forearm resting on 
a table with palm turned upward. With the subject’s finger flexor 
muscles relaxed, begin recording the EMG signal. After approxi-
mately five seconds, have the subject contract the finger flexor 
muscles gently (make a fist) and hold for about two seconds, then 
relax again. Alternate periods of rest, with progressively stronger 
contractions until the subject contracts the flexor muscles maximally, 
then stop recording. 

 Figure A-12

Troubleshooting
¥ In DC mode, trace remains maxed to one side, offset has no effect. 
Check that the transducer is not overloaded and that the gain is not set too 
high  the ETH-256 and your recorder may be accurate. If your transducer 
is not reacting to a large pressure or force, there are only two explanations 
for a large offset. The first is that one of the inputs to the differential amplifier 
on this channel is not connected. The second is that one of the power leads 
that supply the transducer may have shorted to the input or directly to 
ground. In either case, open the connector on the transducer and confirm 
that the wiring is correct and that there are no shorts.

¥ In the DC mode, when using the ETH-256 with data acquisition 
devices sampling at low speed, a slow sinusoidal drift appears. 
Sinusoidal drift observed when using digital recording devices is almost 
always due to aliasing of higher frequency noise. The most likely culprit in 
this case is the mains frequency. Use the 50Hz low-pass filter on the ETH-
256 and any mains frequency or line filters that may be available on your 
recorder to minimize or remove this artifact.
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¥ \When using a high pass filter other than DC, the signal is noisy and 
wanders. Noise in the recording of biopotentials is frequently from the power 
lines in the room. Normally the differential properties of the amplifier can 
remove it, but this becomes difficult if the electrode connection to the subject 
is of high or variable resistance. Make sure that surface electrodes are 
securely fastened to the subject by gently abrading the skin surface where 
the electrode will be attached with some nylon scrubbing material. Be sure to 
use enough electrode gel if you have German silver (reusable) electrodes.

¥ The offset works, you can see the trace, but there is no signal. Make 
sure that you are using enough gain to see the changes produced by your 
transducer or by an ECG/EMG. Remember these signals can be just a few 
millivolts. If you use the 10V scale you won’t see much.

¥ Check the obvious: Are the amplifier and recorder connected to a working 
outlet? Are you turning the switches and knobs on the correct channel?   Are 
you sure about the connection to your recorder? 

Specifications
Number of Channels: 2

Operational Modes: Bridge/Biopotential(ECG, EMG,EEG)

Gain: x1, x5, x10, x50, x100, x500, x1k, x5k

Filters: High Pass (Hz): DC, 0.03, 0.3, 3.0

Low Pass (Hz): 5.0, 50, 150, 2 k, 10 k

Power Source Wall 

Adapter: 12 VAC, 1 Amp

Ground Isolation: Optical with C-ISO-256 isolated cable

Input Impedance: 10 GOhm

Output Impedance: 100 Ohm

Input Connectors: DIN 8 or BNC

Output Connectors: BNC 

Offset Range: –5V 

Excitation Current: 50 mA per channel 

Excitation Voltage: –5V 

CMR 85dB up to 200 hz
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Appendix F: Amplifier Tables

You’ll probably find this table and legend helpful when choosing 
which iWorx products are suitable for your applications.

Table 1: Circulatory System

Physiological 
Parameters

Measurement
Required

Sensing Devices
Used

Typical
Parameter
Amplitude

Parameter
Frequency

(Hz)

Appropriate
Amplifier

Accessories/
Sensors

Heart Potentials Electrocardio-
gram

Surface Elec-
trodes

2mV 0.05-80 ETH-256
PA-400

Surface Elec-
trodes

Heart Electrodes 50mV 0.05-80

Vector cardio-
gram

Surface Elec-
trodes

2µV 0.05-80 ETH-256
PA-400

Surface Elec-
trodes

Fetal Electro-
cardiogram

Surface Elec-
trodes (mother)

10µV 2-100 ETH-256
PA-400

Surface Elec-
trodes

Blood Pressure Direct Arterial 
Pressure at 
Brachial Artery

Pressure 
Transducer

120mmHg DC-20 ETH-200
ETH-400
ETH-256

BP-100

Direct Arterial 
Pressure at 
Femoral Artery

Mercury Manom-
eter

120mmHg DC-20 ETH-200
ETH-400
ETH-256

BP-100

Direct Venous 
Pressure

Pressure Trans-
ducer

9mmHg DC-20 ETH-200
ETH-400
ETH-256

BP-100

Indirect 
Arterial
Pressure

Sphygmomanom-
eter

120/
80mmHg

ETH-200
ETH-400
ETH-256

Cuff 
BP-100

Korotkoff 
Microphone

150mV 30-500 ETH-256
PA-400

Table 2: Respiratory System

Physiological
Parameter

Measurement
Required

Sensing Devices
Used

Typical
Parameter
Amplitude

Parameter
Frequency 

(Hz)

Appropriate
Amplifier

Accessories/
Sensors

Breathing Pneumogam Thermistor 
Pneumograph

500cc/breath 0.05-2 ETH-200
ETH-400
ETH-256
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Respiratory 
Flow

Pneumot-
achogram

Pneumot-
achograph 
w/Pressure 
Transducer

20,000cc/
mL

DC-2 ETH-200
ETH-400
ETH-256

SP-304 
Flow Heads

Respiratory 
Volume

Spirogram Spirometer 4,000cc DC-0.5 ETH-200
ETH-400
ETH-256

SP-304 
Flow Heads

Table 3: Brain Functions

Physiological
Parameter

Measurement
Required

Sensing Devices
Used

Typical
Parameter
Amplitude

Parameter
Frequency

(Hz)

Appropriate
Amplifier

Accessories/
Sensors

Electrical 
Activity

Electroenceph-
alograph

Scalp Electrodes 50µV 0.5-100 ETH-256
PA-400

Electrocap 
Montage

Intracranial Elec-
trodes

500µV 0.5-100 ETH-256
PA-400

Evoked 
Responses

Intracellular 
Potentials

Microelectrodes 100mV 1-10,000 ETH-256
PA-400

Extracellular 
Potentials

Needle Electrodes 50µV 1-1,000 ETH-256
PA-400

DHS-300

Eye Response Electroretino-
gram

Contact Lens 
Electrode

100µV 0.5-20 ETH-256
PA-400

Table 4: Muscular Functions

Physiological
Parameters

Measurement
Required

Sensing Devices
Used

Typical
Parameter
Amplitude

Parameter
Frequency

(Hz)

Appropriate
Amplifier

Accessories/
Sensors

Muscle 
Strength

Myogram Needle or Surface 
Electrodes

1mV 10-5,000 ETH-256
PA-400

Surface 
Electrodes

Muscle 
Potentials

Electromyo-
gram

Needle or Surface 
Electrodes

1mV 10-5,000 ETH-256
PA-400

Electromyogram 
w/Needle or Sur-
face Electrodes

ETH-256
PA-400

Stimulation Stimulate w/Sur-
face Electrodes

ETH-256
PA-400

Table 2: Respiratory System

Physiological
Parameter

Measurement
Required

Sensing Devices
Used

Typical
Parameter
Amplitude

Parameter
Frequency 

(Hz)

Appropriate
Amplifier

Accessories/
Sensors
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Nerve 
Conduction

H Reflex 
Response

Electromyograph 
w/Reduced 
Stimulation

ETH-256
PA-400

Conduction 
Velocity

Electromyo-
graph

10-50,000 ETH-256
PA-400

NBC-200

Smooth Mus-
cle Activity

Electrogastro-
gram

Surface Electrodes 20mV 0.05-2 ETH-256
PA-400

Organ Bath 
Studies

Force Transducer 5gms DC-4 ETH-200
ETH-400
ETH-256

FT-100
FT-302

Table 5: Autonomic Nervous System

Physiological
Parameters

Measurement
Required

Sensing Devices
Used

Typical
Parameter
Amplitude

Parameter
Frequency

(Hz)

Appropriate
Amplifier

Accessories/
Sensors

Sweat Gland 
Activity

Galvanic Skin 
Response

Lead Surface 
Electrodes

50kOhms DC-5 GSR-200

Electrical Skin 
Resistance

Lead Surface 
Electrodes

50kOhms DC-5 GSR-200

Body 
Temperature

Temperature Thermistor Probe 98° F DC-0.1 ETH-200
ETH-400
ETH-256

TM-100

Table 6: Oxygen Measurements

Physiological
Parameters

Measurement
Required

Sensing Devices
Used

Typical
Parameter
Amplitude

Parameter
Frequency

(Hz)

Appropriate
Amplifier

Accessories/
Sensors

Dissolved Oxy-
gen

Clark Style Elec-
trode

1-20nA DC-1 ETOX-M Oxygen 
Electrode

Table 4: Muscular Functions

Physiological
Parameters

Measurement
Required

Sensing Devices
Used

Typical
Parameter
Amplitude

Parameter
Frequency

(Hz)

Appropriate
Amplifier

Accessories/
Sensors
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	Figure 1-1 : A diagram of the front (upper) and rear (lower) of ETH-256
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	Experiment 1: This is LabScribe™ - A Tutorial
	Equipment Setup
	1 Place the ETH-256 unit on the bench, close to the computer.
	2 Use the shielded cable with the four-input breakout box provided and connect it to the National...
	3 Connect the output of channels one and two on the rear panel of the ETH- 256 to the input BNC’s...
	4 Insert the power plug into the rear of the ETH-256 unit and the transformer into the electrical...

	Start the Software
	1 Click the (Windows) Start menu, move the cursor to Programs and then to the iWorx folder and se...
	2 When the program opens, select Load from the Settings menu.
	3 When the dialog box appears select “NI Animal” and then click OK.
	4 Click on the Settings menu again and select the Tutorial settings file.
	5 After a short time, LabScribe will appear on the computer screen with the Tutorials settings (F...
	Figure 1-2 : The LabScribe Window


	Recording with LabScribe
	The Signal
	1 Locate the DIN 8 plug on one end of the plethysmograph cable; insert it carefully into the DIN ...
	2 Locate the plethysmograph on the other end of the cable. Place the unit on the volar surface (w...
	Figure 1-3 : The connection between the plethysmograph and the ETH-256

	3 Set the controls on the ETH-256 (Figure 1-1 on page 1) as follows


	Recording with LabScribe
	1 Click Start (Figure 1-2 on page 4) and record the finger pulse.
	2 Click AutoScale in the channel one title area and see the rhythmic signal get bigger. Possible ...
	3 Click Stop to halt recording. Click and drag the red arrow (in the right margin of the window) ...
	Figure 1-4 : The display icons in the tool bar.

	1 Click the left icon (big mountain) and notice that the trace spreads out— the Display Time is 5...
	2 Click the right icon (small mountains) twice and see that the rhythmic peaks get closer—the Dis...
	3 Click the left icon once to return to a Display Time of 10 seconds.

	Saving a LabScribe File
	1 Click on the File menu and select Save As.
	2 When the standard panel appears, type a meaningful name. Click Save to save the file(.iwd) to a...

	Making Marks on a Record
	1 Click Start.
	2 Type “my first comment” on the keyboard and notice that the words appear in the Marks area to t...
	3 Press the Enter key on the keyboard and notice that
	4 Type “my next comment” repeat step #3.
	5 Repeat to enter a total of five different comments, pressing Enter after each.
	6 Click Stop.
	7 Select Save in the File menu to update your file.

	Data Analysis of your LabScribe File
	Figure 1-5 : The Windows icons in the toolbar.

	Data Analysis in the Main Window
	Navigating the Main Window
	1 Move the cursor to the scroll bar in the lower margin.
	2 Click the arrows to scroll the screen to the left or right; notice the typed marks in the lower...
	1 Click in the Windows menu and select Marks, or click in the Marks icon in the toolbar (Figure 1...
	2 Click on the time and then GoTo.
	3 The panel will disappear and the relevant portion of data will be displayed in the center of th...


	Making Measurements in the LabScribe Window
	Figure 1-6 : The cursor icons in the tool bar.
	Using a Single Cursor
	1 Click the right cursor icon, with a single vertical bar—a (blue) vertical line appears over the...
	2 Click and drag the line to the left or right to make measurements of:

	Using Two Cursors
	1 Click the left cursor icon, with two vertical bars—two (blue) vertical lines appear over the re...
	2 Click and drag either or both lines to the left or right to display the difference in:
	Figure 1-7 : A finger pulse recorded in the Main window.


	The Journal

	Data Analysis in the Analysis Window
	Figure 1-8 : A finger pulse recorded in the Analysis window.
	1 Click the left cursor icon, with two vertical bars (Figure 1-6 on page 9)— two blue vertical li...
	2 Drag the cursors left and right until a region of interest is located between the two blue lines.
	3 Open the Analysis window by either:
	Channel Display
	1 Find the list of channels displayed.
	2 Click to de-select all but channel one—the one with your finger pulse.

	Screen Display
	Data Values
	1 Move the cursor so that the symbol on each is located on adjacent peaks of your finger pulse re...
	2 Read off the time difference (t2 - t1) between the two cursors.
	3 What is your heart rate (60/(t2 - t1))?
	4 Right mouse click in the Analysis window and select:
	5 Select Copy (Edit menu), open the Journal (Windows menu or click the icon (Figure 1-5 on page 8...
	6 Return to the main window

	Channel Features
	1 Place the cursor over channel two, right click the mouse and select Integrate.
	2 Click the left cursor icon, with two vertical bars (Figure 1-6 on page 9)— two blue vertical li...
	3 Drag the cursors left and right until a region of interest is located between the two blue lines.
	4 Open the Analysis window by either:
	5 Your data may look like Figure 1-9 on page 13.
	Figure 1-9 : Finger pulse (upper trace) and its integral (lower trace) in the Analysis windows.






	Chpt2.
	Chapter 2: Cardiovascular Physiology
	Overview
	Figure 2-1 : A diagram to show the circulation of blood around the human body and its association...
	Figure 2-2 : A diagram of the human heart to show the location of the sinoatrial (SA) and atriove...

	Experiment 2: Electrocardiogram and Heart Sounds
	Overview
	Figure 2-3 : ECG trace in the Main window showing the P, QRS, and T waves; the cursors are positi...

	Equipment Required
	Equipment Setup
	1 Connect the ETH-256 unit to the A/D card (described in Chapter 1).
	2 The volunteer should remove all jewelry from their wrists and ankles.
	3 Use an alcohol swab to clean and abrade a region of each wrist which has little or no hair.
	4 Remove the plastic disk from a disposable electrode and apply the electrode to the abraded area...
	5 Attach the cable from the ECG pod unit to channel one on the ETH-256.
	6 Attach one end of each of the three electrode cable to the pod unit and snap the other ends ont...
	7 Use the DIN8 plug to connect the event marker to channel two (Figure 2-4 on page 19).
	8 Set the controls on the ETH-256 as follows:
	9 The volunteer should sit quietly with their hands in their lap.
	Figure 2-4 : The equipment used to measure the ECG from a volunteer.


	Start the Software
	1 Click the (Windows) Start menu, move the cursor to Programs and then to the iWorx folder and se...
	2 When the program opens, select Load from the Settings menu.
	3 When the dialog box appears, select Human and then click OK.
	4 Click on the Settings menu again and select the Heart #1 settings file.
	5 After a short time, LabScribe will appear on the computer screen with the Heart #1 settings.

	Exercise 1: ECG in a Resting Volunteer
	Procedure
	1 Click Start and the click AutoScale in the channel one title area and see the rhythmic ECG signal.
	2 Have the volunteer open and close their fists, or move their arms across their chest. Notice th...
	3 When you have a suitable trace type "***’s resting ECG" (where *** is the volunteer’s name) and...
	4 Click Stop to halt recording; your data may look like Figure 2-3 on page 17.
	5 Select Save As in the File menu, type a meaningful name and save the file in an appropriate pla...

	Data Analysis
	1 Click the 2 cursor icon (Figure 2-5 on page 20), so that two blue vertical lines appear over th...
	2 Drag the cursors left and right so that four heart beat cycles are located between the two blue...
	3 Click the Analysis icon (Figure 2-5 on page 20) to open the Analysis window.
	Figure 2-5 : The LabScribe toolbar

	4 Click to de-select channel two, to display only the ECG trace.
	5 Use the mouse to click and drag the cursors around the Analysis window to measure:
	6 Data should be entered into the Journal either by typing the values directly, or by typing a ti...
	7 Calculate (and type your results in your Journal):

	Questions
	1 Is the amplitude of the different waves the same in different cardiac cycles?
	2 Which wave has the largest amplitude?
	3 What is the heart rate?


	Exercise 2: ECG Recordings from other Students
	Procedure
	1 Disconnect the leads from the volunteers wrists and ankle and place them on a second student. R...
	2 Repeat until all students have recorded their ECG.

	Data Analysis
	Questions
	1 Is the amplitude of the different waves the same in different individuals? Why?
	2 For each individual which wave has the largest amplitude? Is this result the same for all indiv...
	3 Is the heart rate the same for each individual?
	4 What variation is there within the class?
	5 Is there any obvious correlation between heart rate and sex, apparent fitness, diet?


	Exercise 3: ECG and Heart Sounds
	Procedure
	1 The operator should place the head of the stethoscope on the left side of the volunteer’s chest...
	2 The operator should click Start and, holding the stethoscope head in one hand and the event mar...
	3 After a few heart beat cycles, click Stop to halt recording.
	4 Select Save in the File menu.

	Data Analysis
	1 Click the 2 cursor icon (Figure 2-5 on page 20), so that two blue vertical lines appear over th...
	2 Drag the cursors left and right so that one heart beat cycle is located between the two blue li...
	3 Click the Analysis icon (Figure 2-5 on page 20) to open the Analysis window.
	4 Use the mouse to click and drag one cursor to measure the time delay (t2- t1) between:
	5 Data should be entered into the Journal either by typing the values directly, or by typing a ti...
	6 Copy the trace and paste it into the Journal.
	7 Repeat the above measurements with at least three other cardiac cycles.
	Figure 2-6 : An ECG (upper trace) correlated with heart sounds (lower trace).


	Questions
	1 Why is the lub sound recorded around the peak of the QRS wave?
	2 Is the time delay between the QRS wave and the lub sound always the same? Should it be, and why...
	3 Why is the dup sound recorded around the peak of the T wave?
	4 Is the time delay between the T wave and the dup sound always the same? Should it be, and why i...



	Experiment 3: Electrocardiogram and Peripheral Circulation
	Overview
	Equipment Required
	Equipment Setup
	1 Connect the ETH-256 to the computer (described in Chapter 1).
	2 The volunteer should remove all jewelry from their wrists and ankles.
	3 Use an alcohol swab to clean and abrade a region of each wrist which has little or no hair.
	4 Remove the plastic disk from a disposable electrode and apply the electrode to the abraded area...
	5 Attach the cable from the gray ECG pod unit to channel one on the ETH- 256 unit.
	6 Attach one end of each of the three electrode cables to the pod unit and snap the other ends on...
	7 Set the controls on the ETH-256 as follows
	8 Place the plethysmograph on the volar surface (where the fingerprints are located) of the dista...
	9 Locate the DIN8 plug on the other end of the cable; push it into the channel two DIN8 receptacle.
	10 The volunteer should sit quietly.
	Figure 2-7 : The equipment used to measure an ECG and blood flow from a volunteer.


	Start the Software
	1 Click the (Windows) Start menu, move the cursor to Programs and then to the iWorx folder and se...
	2 When the program opens, select Load from the Settings menu.
	3 When the dialog box appears, select Human and then click OK.
	4 Click on the Settings menu again and select the Heart #2 settings file.
	5 After a short time, LabScribe will appear on the computer screen with the Heart #2 settings.

	Exercise 1: ECG and Volume Pulse in a Resting Volunteer
	Procedure
	1 Click Start and the click AutoScale in the channel one title area and see the rhythmic ECG signal.
	2 Click AutoScale in the channel two and then the channel three title areas and see the rhythmic ...
	3 Type “ECG and finger pulse,” press Enter on the keyboard and click Stop to halt recording. Your...
	4 Select Save As in the File menu, type a meaningful name and save the file in an appropriate pla...
	Figure 2-8 : An ECG (upper trace), plethysmograph recording of blood flow (middle trace) and its ...


	Data Analysis
	1 Click the 2 cursor icon (Figure 2-9 on page 26), so that two blue vertical lines appear over th...
	2 Drag the cursors left and right so that two or three heart beat cycles are located between the ...
	3 Click the Analysis icon (Figure 2-9 on page 26) to open the Analysis window.
	Figure 2-9 : The LabScribe toolbar

	4 Click to de-select channel two to display the ECG and the integrated finger pulse traces.
	5 Use the mouse to click and drag one cursor to the peak of the QRS wave and the second cursor to...
	6 Enter the time (t2-t1) difference into the Journal either by typing the values directly, or by ...

	Questions
	1 What produces the QRS wave in the ECG?
	2 What does the peak of the blood flow trace represent?
	3 What processes, therefore, take place between these two events?
	4 What, therefore, does this time value represent?
	5 Does the falling phase of the volume pulse have a small, transient plateau or upward deflection...
	6 Would you expect a transient increase in blood pressure as the elastic arteries recoil after be...


	Exercise 2: The Volume Pulse
	Procedure
	1 Remove the equipment from the volunteer— the ECG equipment is no longer needed.
	2 Strap the plethysmograph to another student, make a recording and examine the volume pulse trace.
	3 Repeat for all students and type comments to label the relevant sections of data with the stude...
	4 Select Save in the File menu.

	Questions
	1 Do all student traces have a dicrotic notch?
	2 Is the size of the dicrotic notch correlated with age, smoking or fitness?


	Exercise 3: The Effect of Cold on Volume Pulse
	Procedure
	1 Strap the plethysmograph to the middle finger of the volunteer’s left hand.
	2 Make a recording for about one minute and type “cold” on the keyboard.
	3 Place a bag of ice and cold water on the left forearm and at the same time press Enter on the k...
	4 Record for about two minutes, type “remove” and then simultaneously remove the ice and press En...
	5 Record for about two minutes and click Stop to halt recording.
	6 Select Save in the File menu.

	Data Analysis
	1 Use the two cursors to locate the first two “good” adjacent peaks at the beginning of the race.
	2 Use the cursors to measure:
	3 Repeat these measurements every 10 seconds through your trace to see the effects of cooling and...

	Questions
	1 What is the effect of cooling on peripheral circulation?
	2 What factors change peripheral circulation?
	3 What is the effect of cooling on heart rate. Explain your observations.


	Exercise 4: The Effect of Heat on Volume Pulse
	Procedure
	1 Move the plethysmograph to the middle finger of the right hand.
	2 Repeat the above, but this time place a bag of hot water on the right forearm.

	Questions


	Experiment 4: Exercise, the Electrocardiogram and Peripheral Circulation
	Overview
	Equipment Required
	Equipment Setup
	1 Connect the ETH-256 unit to the A/D card (described in Chapter 1).
	2 The volunteer should remove all jewelry from their wrists and ankles.
	3 Use an alcohol swab to clean and abrade a region of each wrist which has little or no hair.
	4 Remove the plastic disk from a disposable electrode and apply the electrode to the abraded area...
	5 Attach the cable from the ECG pod unit to channel one on the ETH-256 unit.
	6 Attach the snap end of each of the three electrode cables to the disposable electrodes, so that:
	7 Place the plethysmograph on the volar surface (where the fingerprints are located) of the dista...
	8 Locate the DIN 8 plug on the other end of the plethysmograph cable; push it into the pod connec...
	9 Set the controls on the ETH-256 as follows:
	10 The volunteer should sit quietly.
	Figure 2-10 : Equipment used to measure an ECG and blood flow from a volunteer.


	Start the Software
	1 Click the (Windows) Start menu, move the cursor to Programs and then to the iWorx folder and se...
	2 When the program opens, select Load from the Settings menu.
	3 When the dialog box appears, select Human and then click OK.
	4 Click on the Settings menu again and select the Heart #3 settings file.
	5 After a short time, LabScribe will appear on the computer screen with the Heart #3 settings.

	Exercise 1: ECG and Volume Pulse in a Resting Volunteer
	Procedure
	1 Click Start and the click AutoScale in the channel one title area and see the rhythmic ECG signal.
	2 Click AutoScale in the channel two and then in the channel three title areas and see the rhythm...
	3 Type “ECG and finger pulse,” press Enter on the keyboard and click Stop to halt recording. Your...
	4 Select Save As in the File menu, type a meaningful name and save the file in an appropriate pla...
	Figure 2-11 : An ECG (upper trace), plethysmograph recording of blood flow (middle trace) and its...



	Exercise 2: ECG and Volume Pulse after Exercise
	Procedure
	1 Disconnect the ECG leads and the plethysmograph BNC connector from the ETH-256. Check that the ...
	2 Remember that the ECG leads are still attached to the electrodes, so the volunteer should exerc...
	3 Immediately after exercise, connect the two connectors into the ETH-256 while the volunteer sit...
	4 Click Start, and record until the heart (and breathing) rate have returned to normal; during th...
	5 Click Stop to halt recording.
	6 Select Save in the File menu.

	Data Analysis
	1 Click the 2 cursor icon (Figure 2-12 on page 33), so that two blue vertical lines appear over t...
	2 Drag the cursors left and right so that three heart beat cycles are located between the two blu...
	3 Click the Analysis icon (Figure 2-12 on page 33) to open the Analysis window.
	Figure 2-12 : The LabScribe toolbar

	4 Click to de-select channels two and three to display only the ECG.
	5 Use the mouse to click and drag the two cursors to measure (Figure 2-13 on page 34) within each...
	Figure 2-13 : An ECG trace recorded from a volunteer with labels to indicate the time values to b...

	6 Enter the time (t2-t1) difference into the Journal either by typing the values directly, or by ...

	Questions
	1 Look at the three values for the P-R interval in the resting person. Are they constant? Explain...
	2 Look at the three values for the P-R interval immediately after exercise. Are they constant? Ex...
	3 Look at the three values for the P-R interval 30 and then 60 seconds after exercise. Are the va...
	4 Repeat steps 1 through 3 for the R-T, T-R and R-R intervals.
	5 Look at the two values for R-R interval at rest and for the three times after exercise. Are the...
	6 Calculate the differences in the mean values of the time values obtained at rest and immediatel...

	More Data Analysis
	1 Look at the finger pulse trace recorded immediately after exercise.
	2 Use the cursors to measure the amplitude of a signal every 10 seconds for the entire record, or...

	Questions
	1 What is the effect of exercise on the rate of blood flow through the fingers?
	2 Is it possible that blood flow may be effected more if the exercise is directed at the arm—rath...


	Exercise 3: Finger Pulse after Hand Exercise
	Procedure
	1 Disconnect the ECG leads from the volunteer.
	2 Grasp the dynamometer in the palm of the left hand (the hand to which the plethysmograph is att...
	3 Rhythmically squeeze the dynamometer bulb for a few minutes or until the forearm muscles fatigue.
	4 Click Start and stop exercising—record for three minutes or until the amplitude of the finger p...
	5 Click Stop to halt recording.
	6 Select Save in the File menu.

	Data Analysis
	1 Look at the finger pulse trace recorded immediately after exercise.
	2 Use the cursors to measure the amplitude of a signal every 10 seconds for the entire record, or...
	3 Enter your data into the Journal.

	Questions
	1 What is the effect of hand exercise on the rate of blood flow through the fingers?
	2 Compare the data from the first session of exercise. Are they the same or different? Explain yo...



	Experiment 5: Blood Pressure, Peripheral Circulation and Body Position
	Overview
	1 Know what you are doing ahead of time.
	2 Do not leave the cuff inflated for any prolonged period of time (>30 seconds).
	3 The volunteer should flex and extend their fingers between experiments to maintain blood flow.
	4 This experiment should be performed by healthy individuals who do not have a personal or family...

	Equipment Required
	Equipment Setup
	1 Connect the ETH-256 unit to the A/D card (described in Chapter 1).
	2 Untangle to plethysmograph cable.
	3 Place the plethysmograph on the volar surface (where the fingerprints are located) of the dista...
	4 Push the DIN plug on the other end of the cable into the socket labeled channel one.
	5 Place the blood pressure cuff around the upper portion of the left arm, between the elbow and t...
	6 Set the controls on the ETH 256 as follows:
	7 The volunteer should sit quietly.
	Figure 2-14 : The equipment used to measure blood flow from a volunteer.


	Start the Software
	1 Click the (Windows) Start menu, move the cursor to Programs and then to the iWorx folder and se...
	2 When the program opens, select Load from the Settings menu.
	3 When the dialog box appears, select Human and then click OK.
	4 Click on the Settings menu again and select the Heart #4 settings file.
	5 After a short time, LabScribe will appear on the computer screen with the Heart #4 settings.

	Exercise 1: Procedure for Measuring Blood Pressure
	Procedure
	1 Ask the volunteer to sit down and relax, with both hands in their lap.
	2 Click Start and record the finger pulse.
	3 Click AutoScale in the channel one title area and see the rhythmic signal get bigger. During th...
	4 Inflate the cuff until the pressure is just above 200 mmHg— notice that the finger pulse disapp...
	Figure 2-15 : A finger pulse recorded during blood pressure measurements. In this experiment a fe...

	5 Slowly release the cuff pressure; when the pressure reaches 200 press the Enter key on the keyb...
	6 When the cuff reaches 40 click Stop and remove the cuff. The volunteer should flex and extend t...
	7 Select Save As in the File menu, type a meaningful name and save the file in an appropriate pla...

	Data Analysis - Measuring Blood Pressure
	1 Click the 2 cursor icon (Figure 2-16 on page 40), so that two blue vertical lines appear over t...
	2 Drag the cursors left and right to place them on either side of a pair marks between which the ...
	3 Click the Analysis icon (Figure 2-16 on page 40) to open the Analysis window.
	Figure 2-16 : The LabScribe toolbar
	Figure 2-17 : The finger pulse trace showing the recording taken as cuff pressure declined from 1...

	4 Place one cursor on the peak of the smallest signal (Figure 2-17 on page 40) and the second cur...
	5 Calculate: value #2 x 20
	6 Add this number to the lowest value in the bracket (100 in the above example) to give you the s...


	Exercise 2: Repeat the Measurement
	Procedure
	Questions
	1 Are the values for blood pressure (systolic and diastolic) identical? Can you explain any varia...
	2 Since you are looking for changes in the volume pulse, would slowing the rate of pressure relea...


	Exercise 3: Measurements from the Right Arm
	Procedure
	1 With the plethysmograph still on the left hand, place the cuff around the upper portion of the ...
	2 Inflate the cuff—does the finger pulse signal disappear? Deflate the cuff. Why does the finger ...
	1 Place the plethysmograph on the distal segment of the middle finger of the right hand and wrap ...
	2 Measure the blood pressure as described above, making two separate measurements.

	Questions

	Exercise 4: Measurements with the Cuff on the Forearm
	Procedure
	1 Move the cuff from the upper right arm to the lower right arm.
	2 Measure the blood pressure as described above.

	Questions

	Exercise 5: Arm Position
	Procedure
	1 Move the cuff to the upper left arm (this may be a good time to switch volunteers).
	2 Measure the amplitude of the finger pulse and blood pressure with both hands in lap.
	3 Have the volunteer place their right hand on their head and repeat step 2.
	4 Have the volunteer place their left hand on their head and repeat step 2.

	Questions

	Exercise 6: Measurements from the Leg
	Procedure
	1 The volunteer should sit and remove the left shoe and sock.
	2 Place the plethysmograph on the distal segment of the big toe and wrap the Velcro to attach the...
	3 Wrap the cuff around the calf of the left leg.
	4 Inflate the cuff and measure the blood pressure as described above, making two separate measure...

	Questions
	1 Are the values the same as those obtained for the arms? Explain any differences.
	2 What happens to finger pulse and blood pressure when:



	Experiment 6: Blood Pressure, Peripheral Circulation and Imposed Conditions
	Overview
	1 Know what you are doing ahead of time.
	2 Do not leave the cuff inflated for any prolonged period of time (>30 seconds).
	3 The volunteer should flex and extend their fingers between experiments to maintain blood flow.
	4 This experiment should be performed by healthy individuals who do not have a personal or family...

	Equipment Required
	Equipment Setup
	1 Connect the ETH-256 unit to the A/D card (described in Chapter 1).
	2 Untangle the plethysmograph cable.
	3 Place the plethysmograph on the volar surface (where the fingerprints are located) of the dista...
	4 Push the DIN 8 plug on the other end of the cable into the socket labeled channel one.
	5 Place the blood pressure cuff around the upper portion of the left arm, between the elbow and t...
	6 Set the controls on the ETH-256 as follows :
	7 The volunteer should sit quietly.
	Figure 2-18 : The equipment used to measure blood flow from a volunteer.


	Start the Software
	1 Click the (Windows) Start menu, move the cursor to Programs and then to the iWorx folder and se...
	2 When the program opens select Load from the Settings menu.
	3 When the dialog box appears select Human and then click OK.
	4 Click on the Settings menu again and select the Heart #5 settings file.
	5 After a short time, LabScribe will appear on the computer screen with the Heart #5 settings.

	Exercise 1: Procedure for Measuring Blood Pressure
	Procedure
	1 Ask the volunteer to sit down and relax, with both hands in their lap.
	2 Click Start and record the finger pulse.
	3 Click AutoScale in the channel one title area and see the rhythmic signal get bigger. During th...
	4 Inflate the cuff until the pressure is just above 200mmHg—notice that the finger pulse disappea...
	Figure 2-19 : A finger pulse recorded during blood pressure measurements. In this experiment a fe...

	5 Slowly release the cuff pressure; when the pressure reaches 200 press the Enter key on the keyb...
	6 When the cuff reaches 40 click Stop and remove the cuff. The volunteer should flex and extend t...
	7 Select Save As in the File menu, type a meaningful name and save the file in an appropriate pla...

	Data Analysis - Measure Blood Pressure
	1 Click the 2 cursor icon (Figure 2-20 on page 47), so that two blue vertical lines appear over t...
	2 Drag the cursors left and right to place them on either side of a pair marks between which the ...
	3 Click the Analysis icon (Figure 2-20 on page 47) to open the Analysis window.
	Figure 2-20 : The LabScribe toolbar
	Figure 2-21 : The finger pulse trace showing the recording taken as cuff pressure declined from 1...

	4 Place one cursor on the peak of the smallest signal (Figure 2-21 on page 47) and the second cur...
	5 Calculate: value #2 x 20
	6 Add this number to the lowest value in the bracket (100 in the above example) to give you the s...

	Lab Procedure

	Exercise 2: Effects of Food Additives (long- term)
	Procedure
	1 Ask the volunteer to sit down and relax, with both hands in their lap.
	2 With the cuff around the left upper arm and the plethysmograph on the left middle finger:
	3 Have the volunteer drink their designated soda.
	4 Repeat steps #1 and #2 every 20 minutes (enter appropriate comments, including the time after t...
	Figure 2-22 : The integral of the plethysmograph signal in the Analysis window.


	Data Analysis
	1 Measure the blood pressure, the amplitude of the volume pulse (place the cursors prior to and a...
	2 Use a line graph to show the effects over time.

	Questions
	1 Compare the data sets to see the effects of the different additives on blood pressure, peripher...
	2 Explain your results


	The Short-Term Experiments
	Exercise 3: Effects of Exercise
	Procedure
	1 Loosely attach the blood pressure cuff to the volunteer’s left upper arm, and firmly wrap the p...
	2 Remove the plethysmograph’s connector from the ETH-256 unit and ask the volunteer to hold it in...
	3 Ask the volunteer to exercise carefully, with minimal class disruption but rigorously enough to...
	4 Immediately after exercise, reattach the connector to channel one.
	5 Click Start, inflate the cuff and measure the blood pressure; after deflation type “recovery fr...
	6 Click Stop to halt recording.
	7 Select Save from the File menu.

	Data Analysis
	Questions

	Exercise 4: Apnea (holding breath)
	Procedure
	1 If a new volunteer is used, first measure their resting blood pressure.
	2 As a preliminary study, simply record volume pulse and have the volunteer take in a deep breath...

	Questions
	1 What is the effect of periods of apnea on heart rate and the amplitude of the volume pulse?
	2 Are there any changes when breathing is initiated once more?
	3 Explain your results. Do you think apnea has an effect on blood pressure?

	Procedure
	Questions
	1 What is the effect of apnea on blood pressure?
	2 Explain your results.


	Exercise 5: Cooling the Forearm
	Procedure
	1 Place the plethysmograph on the right middle finger.
	2 Record volume pulse for 60 seconds.
	3 Apply a bag of ice water on the volunteer’s right forearm.
	4 Remove after two minutes and record during recovery—until the volume pulse trace is reasonably ...

	Data Analysis
	1 Select the first two “good” adjacent peaks at the beginning of the volume. pulse trace.
	2 Use the two cursors to measure:
	3 Repeat these measurements every 15 seconds through your trace to see the effects of cooling and...
	4 Graph your results with respect to time, indicating the time when ice was applied and removed.

	Questions
	1 What is the effect of cooling on peripheral circulation and heart rate? Explain your data.
	2 Would you expect blood pressure to change during this process?

	Procedure
	1 Place the plethysmograph on the left middle finger and the cuff on the left upper arm.
	2 Repeat the above procedure, but measure blood pressure quickly after the ice bag has been appli...

	Questions

	Exercise 6: Warming the Forearm
	Procedure




	Chap3
	Chapter 3: Neuromuscular Physiology
	Overview
	Figure 3-1 : A diagram of a sarcomere showing the Z lines, I bands and A band (upper) and the ass...
	Figure 3-2 : Diagrams of the myosin molecule and an actin filament— each sphere represents a mole...

	Experiment 7: Electromyograms (EMGs)
	Overview
	Equipment Required
	Equipment Setup
	1 Connect the ETH-256 unit to the A/D card (described in Chapter 1).
	2 The volunteer should remove all jewelry from their wrists and ankles.
	3 Use an alcohol swab to clean and abrade the three regions for electrode attachment on the right...
	4 Remove the plastic disk from a disposable electrode and apply the electrode to one abraded area...
	5 Attach the cable from the black pod unit to channel one on the ETH-256 unit.
	6 Set the controls on the ETH-256 as follows:
	7 Attach the three electrode cables to the pod unit and snap the other ends onto the disposable e...
	8 The volunteer should hold a small object (like keys or a pen knife) in their right hand.
	Figure 3-3 : The equipment used to monitor EMGs and resulting finger movements from a volunteer.


	Start the Software
	1 Click the (Windows) Start menu, move the cursor to Programs and then to the iWorx folder and se...
	2 When the program opens, select Load from the Settings menu.
	3 When the dialog box appears, select Human and then click OK.
	4 Click on the Settings menu again and select the Muscle #1 settings file.
	5 After a short time, LabScribe will appear on the computer screen with the Muscle #1 settings.

	Exercise 1: Recruitment and the EMG

	Procedure
	1 Click Start and the click AutoScale in the channel one title area then AutoScale channel two.
	2 Ask the volunteer to squeeze the object in their hand using a single, brief contraction (twitch...
	3 Type “EMG and increasing twitches,” press Enter on the keyboard and click Stop to halt recording.
	4 Select Save As in the File menu, type a meaningful name and save the file in an appropriate pla...

	Data Analysis
	1 Right click on the channel two display area and select Integrate.
	2 Scroll the first twitch recording to the center of the screen.
	3 Click the 2 cursor icon (Figure 3-4 on page 57), so that two blue vertical lines appear over th...
	4 Click the Analysis icon (Figure 3-4 on page 57) to open the Analysis window.
	Figure 3-4 : LabScribe toolbar

	5 Use the mouse to click and drag one cursor to the baseline, prior to the first response, and th...
	6 Click in the top left margin to select data values from channel two and enter the voltage (v2-v...
	7 Repeat for all responses.
	Figure 3-5 : The EMG recording during three increasing finger movements.


	Questions
	1 Is there a correlation between the amplitude of the integrated EMG signal and the amount of con...
	2 Look at your data. Is the duration (length) of each integrated signal about the same for each c...
	3 Are all of the EMG responses approximately the same duration?
	4 How do you explain the increase in the amplitude of the integrated EMG signal with an increase ...
	Exercise 2: Maximum Finger Contraction

	Procedure
	1 Click Start and type “hard squeeze.”
	2 Ask the volunteer to squeeze the object in their hand as hard as possible to produce maximum te...
	3 Click Stop to halt recording.
	4 Select Save in the File menu.
	Figure 3-6 : An EMG recording during a maximum contraction.


	Data Analysis
	1 Click the 2 cursor icon (Figure 3-4 on page 57), so that two blue vertical lines appear over th...
	2 Click the Analysis icon (Figure 3-4 on page 57) to open the Analysis window.
	3 Use the mouse to click and drag:
	4 Repeat the above measurements for the last response in the previous exercise—i.e. the “largest”...

	Questions
	1 Using the EMG integral data, compare the amplitude of the maximum squeeze with the maximum sing...
	2 If all fibers were contracting in both instances (maximum squeeze and single twitches) explain ...
	3 Compare the duration of this maximum squeeze contraction with the maximum contraction produced ...
	4 Does your answer to question #2 fit with your answer to question #3?
	Exercise 3: Tetanus and Movement

	Procedure
	1 Remove the recording electrodes from the forearm and place them on the biceps—as shown in Figur...
	Figure 3-7 : The equipment used to monitor EMGs from the biceps muscle of a volunteer.

	2 Ask the volunteer to sit on a chair and support their right elbow with their left hand. Ask the...
	3 Click Start and type “tetanus.”
	4 Ask the volunteer to bend their right arm against the weight of the bench top, press Enter on t...
	5 After 15 seconds of hard contraction ask the volunteer to stop, extend their arm and relax (the...
	6 Click Stop to halt recording.
	7 Select Save in the File menu.

	Questions
	1 During the contraction did the angle between the upper arm and lower arm change significantly?
	2 When the volunteer relaxed after the contraction, were EMGs recorded?
	3 During relaxation did the angle between the upper arm and lower arm change significantly?
	4 How can you explain a movement in the absence of significant EMG activity?
	Exercise 4: Integration of Motor Activity

	Procedure
	1 Ask the volunteer to sit on a chair and support their right elbow with their left hand.
	2 Click Start and type “no weight - biceps” and press Enter on the keyboard.
	3 Ask the volunteer to bend and extend their arm slowly—type “bend” and press Enter every time th...
	4 Repeat the above contracting against a reasonably heavy weight like a book bag (type and Enter ...
	5 Click Stop to halt recording.
	6 Select Save in the File menu.
	7 Move the electrodes to the (antagonistic) triceps muscle and repeat the above.

	Questions
	1 Is the EMG activity greater when moving the book bag than without? What does this tell you abou...
	2 When the bag is held at arm’s length, is EMG activity constant for the duration of the experime...
	3 With a constant load being lifted, why would muscle activity increase?
	Experiment 8: Reflexes and Reaction Times
	Overview
	Figure 3-8 : A cross section of the spinal cord showing the single synapse between the sensory an...

	Equipment Required
	Equipment Setup
	1 Connect the ETH-256 unit to the A/D card (described in Chapter 1).
	2 Plug the event marker into the DIN8 socket on channel one.
	3 Plug the plethysmograph into the DIN8 socket on channel two.
	4 The equipment should look like Figure 3-9 on page 63.
	Figure 3-9 : The equipment used to measure reaction times from a volunteer.


	Start the Software
	1 Click the (Windows) Start menu, move the cursor to Programs and then to the iWorx folder and se...
	2 When the program opens, select Load from the Settings menu.
	3 When the dialog box appears, select Human and then click OK.
	4 Click on the Settings menu again and select the Muscle #3 settings file.
	5 After a short time, LabScribe will appear on the computer screen with the Muscle #3 settings.

	Exercise 1: Reaction Time and Sound


	Procedure
	1 Ask the volunteer to sit in a chair placed in a location so that their back is facing the compu...
	2 Ask the volunteer to relax and listen as another student taps the white surface of the plethysm...
	3 Ask the volunteer to (quickly) click the event marker as soon as they hear the tap.
	4 Click Start.
	5 Present a total of 10 taps, but make sure that the taps are delivered so that the volunteer can...
	6 Click Stop to halt recording.
	7 Select Save As in the File menu, type a meaningful name and save the file in an appropriate pla...

	Data Analysis
	1 Click the 2 cursor icon (Figure 3-10 on page 65), so that two blue vertical lines appear over t...
	2 Drag the cursors left and right so that the large spike on the plethysmograph channel and the s...
	3 Click the Analysis icon (Figure 3-10 on page 65) to open the Analysis window.
	Figure 3-10 : The LabScribe toolbar

	4 Use the mouse to click and drag one cursor to the beginning of the spike on the plethysmograph ...
	5 Enter the time (t2-t1) difference into the Journal either by typing the values directly, or by ...
	6 Use the scroll bars to scroll through your data in the Analysis window and repeat the measureme...
	7 Omit the longest and shortest values and average the remaining eight values to give the mean re...
	Figure 3-11 : Data produced by tapping the plethysmograph which entered a a large spike on CH 2 a...

	Exercise 2: Reaction Time and Prompted Sounds

	Procedure
	Data Analysis
	Exercise 3: Reaction Time and Predictable Sounds

	Procedure
	Data Analysis
	Questions
	1 Is the average reaction time the same for all three conditions?
	2 Does the interval decrease during exercises 2 and 3?
	Exercise 4: Reaction Time and Visual Cues

	Procedure
	1 Ask the volunteer to sit in a chair and face the computer screen.
	2 Ask the volunteer to watch the screen and (quickly) press the event marker button as soon as th...
	3 Click Start; a second student (out of site) should tap the plethysmograph (and the volunteer sh...
	4 Present a total of 10 trials, but make sure that the events are delivered so that the volunteer...
	5 Click Stop to halt recording.
	6 Select Save from the File menu.

	Data Analysis
	1 Use the cursor and the marker to measure the time delay between visual stimulus and response.
	2 Repeat the measurements for all 10 trials.
	3 Omit the longest and shortest values and average the remaining eight values to give the mean re...

	Questions
	Exercise 5: Reflexes

	The Knee-Jerk Reflex
	1 Ask the volunteer to sit in a chair and cross their legs.
	2 Firmly strike the tendon below the knee cap and watch the knee jerk.
	3 Ask the volunteer to cup and link their hands, and then pull outwards (this is the Jendrassil m...

	The Papillary Reflex
	1 Shade the eyes for 30 seconds.
	2 Shine a light into one eye. What is the response of the pupil?
	3 Repeat steps 1 and 2, but note the response of the unstimulated eye.

	The Spinociliary Reflex
	1 A student should look into one of the volunteer’s eyes.
	2 The student should gently stroke the hair in the hair line behind one ear. What is the effect o...
	3 Repeat step #2 but stroke the hair behind the other ear



	Chap4
	Chapter 4: External Respiration
	Overview
	Experiment 9: Breathing Parameters at Rest and after Exercise
	Overview
	Equipment Required
	Equipment Setup
	1 Connect the ETH-256 unit to the A/D card (described in Chapter 1).
	2 Firmly push the two air flow tubes into the two outlets on the flow head.
	3 Firmly push the other ends of the two air flow tubes into the two outlets on the SP-100 spirome...
	4 Use the cable to connect the output on the spirometer unit to the input on channel one of the E...
	Figure 4-1 : Connect the spirometer to the ETH-256 unit.

	5 Set the controls on the ETH-256 as follows:

	Start the Software
	1 Click the (Windows) Start menu, move the cursor to Programs and then to the iWorx folder and se...
	2 When the program opens, select Load from the Settings menu.
	3 When the dialog box appears, select Human and then click OK.
	4 Click on the Settings menu again and select the Lung #1 settings file.
	5 After a short time, LabScribe will appear on the computer screen with the Lung #1 settings.

	Before Starting
	1 The spirometer will monitor breathing from a volunteer. It is important that the volunteer is h...
	2 The tubes on the flow head should always be in the upright position, to avoid problems with con...
	3 Turbulent air flow through the flow head will produce a noisy signal.To avoid turbulent air flo...
	4 The spirometer will display flow on channel one. The software is set to integrate the data you ...

	Exercise 1: Breathing in a Resting Volunteer

	Procedure
	1 The volunteer should hold the spirometer head with the air flow tubes up. Breath normally—this ...
	2 With the resting volunteer breathing normally through the spirometer, click Start, type “restin...
	3 Click AutoScale in the channel one title area. Notice the slow wave on channel two as the volun...
	4 Type “InMax,”,ask the volunteer to inhale as much as possible and press Enter on the keyboard. ...
	5 Click Stop to halt recording.
	6 Select Save As in the File menu, type a meaningful name and save the file in an appropriate pla...

	Data Analysis - Measurements
	Figure 4-2 : A recording in the Main window from a resting volunteer breathing through the spirom...
	1 Click the 2 cursor icon (Figure 4-3 on page 74), so that two blue vertical lines appear over th...
	2 Adjust the Display Time (Figure 4-3 on page 74) if necessary, drag the cursors left and right s...
	3 Click the Analysis icon (Figure 4-3 on page 74) to open the Analysis window.
	Figure 4-3 : The LabScribe toolbar

	4 Use the mouse to click and drag the two cursors to measure, for each of the 5 breathing cycles ...
	Figure 4-4 : The spirometer signal (upper trace) and its integral (lower trace) recorded from a r...
	Figure 4-5 : The integral of the spirometer signal recorded from a resting volunteer and displaye...
	Figure 4-6 : The integral of the spirometer signal recorded from a resting volunteer. The cursors...

	5 Use the markers to measure the tidal (TV) inspiratory reserve (IR) and expiratory reserve (ER) ...
	Figure 4-7 : A recording in the Main window from a resting volunteer breathing through the spirom...


	Data Analysis - Calculations
	1 Use the mean duration of the breathing cycles to measure breathing rate:
	2 Multiply the mean tidal volume (#2) by the breathing rate to calculate the volume of air passin...

	Data Analysis - Tabulation
	Exercise 2: Breathing Parameters from other Students

	Procedure
	1 Wash the spirometer head and wring dry. Be careful not to touch the membrane inside of the flow...
	2 Repeat Exercise #1, labeling each segment of file with the student’s name.
	3 Select Save in the File menu.
	4 Measure the lung volumes for each student.

	Questions
	1 Are the lung volumes the same in all students?
	2 Combine class data to see whether there is any correlation between tidal volume or vital capaci...
	Exercise 3: Breathing in the Volunteer Immediately after Exercise

	Procedure
	1 Attach a clean spirometer head.
	2 The volunteer should exercise sufficiently enough to elevate breathing rate, but with minimal c...
	3 The volunteer should immediately sit down, hold the spirometer by the grip and place the mouthp...
	4 Quickly click Start, type “after exercise,” and press Enter on the keyboard.
	5 After about five breathing cycles, ask the volunteer to inhale as much as possible and then exh...
	6 Click Stop to halt recording.
	7 Select Save in the File menu.

	Data Analysis
	Questions:
	1 Did tidal volume change after exercise?
	2 Did exercise influence the time taken for each breathing cycle?
	3 Did the rate of air flow during the inhaling phase increase with exercise— how can you account ...
	4 Did the rate of air flow during the exhaling phase increase with exercise— **/*+-how can you ac...
	5 Did the volume of air passing in and out of the resting volunteer’s lungs each minute increase ...
	6 Did exercise influence the vital capacity of the individual?
	7 If the tidal volume changed due to exercise, can this be accounted for by changes in the TV, IR...
	Experiment 10: Breathing and Gravity
	Overview
	Equipment Required
	Equipment Setup
	1 Connect the ETH-256 unit to the A/D card (described in Chapter 1).
	2 Firmly push the two air flow tubes into the two outlets on the flow head.
	3 Firmly push the other ends of the two air flow tubes into the two outlets on the SP-100 spirome...
	4 Use the cable to connect the output on the spirometer unit to the input on channel two of the E...
	5 Untangle the plethysmograph cable.
	6 Place the plethysmograph on the volar surface (where the fingerprints are located) of the dista...
	7 Push the DIN 8 plug on the other end of the cable into the socket labeled channel one (Figure 4...
	Figure 4-8 : Attach the spirometer and plethysmograph to the ETH-256.

	8 Set the controls on the ETH-256 as follows

	Start the Software
	1 Click the (Windows) Start menu, move the cursor to Programs and then to the iWorx folder and se...
	2 When the program opens, select Load from the Settings menu.
	3 When the dialog box appears, select Human and then click OK.
	4 Click on the Settings menu again and select the Lung #2 settings file.
	5 After a short time, LabScribe will appear on the computer screen with the Lung #2 settings.

	Before Starting
	1 The spirometer will monitor breathing from a volunteer. It is important that the volunteer is h...
	2 The tubes on the flow head should always be in the upright position, to avoid problems with con...
	3 Turbulent air flow through the flow head will produce a noisy signal.To avoid turbulent air flo...
	4 The spirometer will display flow on channel two. The software is set to integrate the data on c...

	Exercise 1: The Effects of Gravity on Peripheral Circulation


	Procedure
	1 The volunteer should sit quietly with their hands in their lap.
	2 Click Start and record the finger pulse.
	3 Click AutoScale in the channel one title area and see the rhythmic finger pulse signal get bigg...
	4 The volunteer should then place both hands on their head; type “hands on head” and press Enter ...
	5 The volunteer should then reach both hands as high as possible (don’t stretch the cable); type ...
	6 Click Stop to halt recording.
	7 Select Save As in the File menu, type a meaningful name and save the file in an appropriate pla...

	Data Analysis
	1 Use the arrows at the bottom of the window to scroll to the beginning of the recording.
	2 Click the 2 cursor icon (Figure 4-9 on page 82), so that two blue vertical lines appear over th...
	3 Drag the cursors left and right to place them between the first five or so finger pulse signals.
	4 Click the Analysis icon (Figure 4-9 on page 82) to open the Analysis window.
	Figure 4-9 : The LabScribe toolbar

	5 Click to de-select channels two and three.
	6 Click and drag the cursors left and right on channel one to place one on the baseline before th...
	7 Repeat with data obtained in the other two hand positions.
	8 Click the Journal icon (Figure 4-9 on page 82) and label the average value for blood flow in th...
	Figure 4-10 : A recording from the plethysmograph in the Main window where the hands located in t...


	Questions
	1 What happens to the size of the finger pulse when the hands are raised?
	2 If the size of the finger pulse signal indicates blood pressure, what do you think happens to b...
	Exercise 2: Breathing when Standing (or sitting)
	Equipment Setup

	Procedure
	1 The volunteer should hold the spirometer head with the air flow tubes up. Breath normally—this ...
	2 Click Start and record the rhythmic signal produced by the volunteer’s breathing. Type “standin...
	3 After five breathing cycles ask the volunteer to inhale as much as possible (type “inhale” and ...
	4 Click Stop to halt recording.
	5 Select Save in the File menu.

	Data Analysis - Measurements
	1 Use the arrows at the bottom of the window to scroll to the beginning of this section of the re...
	2 Click the 2 cursor icon (Figure 4-9 on page 82), so that two blue vertical lines appear over th...
	3 Drag the cursors left and right to place them between the first two breathing cycles.
	4 Click the Analysis icon (Figure 4-9 on page 82) to open the Analysis window.
	5 Click to de-select channels one and four.
	6 Click and drag the cursors left and right on channel three to place one on the trough of the si...
	7 Scroll through your record in the Analysis window and repeat the above measurement for all brea...
	8 Click the Journal icon (Figure 4-9 on page 82), label your data as a recording of tidal volume ...
	Figure 4-11 : The spirometer signal (upper trace) and its integral (lower trace) recorded from a ...

	1 Proceed as above, except the time (t2-t1) between adjacent peaks Figure 4-12 on page 85.
	2 Click the Journal icon (Figure 4-9 on page 82), label your data as a recording of tidal volume ...
	Figure 4-12 : The integral of the spirometer signal recorded from a resting volunteer and display...

	1 Use the arrows at the bottom of the window to scroll to the beginning of the recording.
	2 Click and drag the cursors left and right on channel three to place them on the steepest portio...
	3 Scroll through your record in the Analysis window and repeat the above measurement for all brea...
	4 Click the Journal icon (Figure 4-9 on page 82), label your data as a recording of tidal volume ...
	Figure 4-13 : The integral of the spirometer signal recorded from a resting volunteer.


	Data Analysis - Calculations
	1 Use the mean duration of the breathing cycles to measure breathing rate:
	2 Multiply the mean tidal volume (#2) by the breathing rate (#1) to calculate the volume of air p...
	Figure 4-14 : A recording in the Main window from a resting volunteer breathing through the spiro...


	Data Analysis - Tabulation
	Exercise 3: Breathing when Lying Down (face up)

	Procedure
	1 The volunteer should lie down on their back and relax.
	2 As before, the volunteer should not be disturbed and should be relaxed and accustomed to breath...
	3 Click Start, type “lying down” and press Enter on the keyboard.
	4 After about five breathing cycles ask the volunteer to inhale as much as possible and then exha...
	5 Click Stop to halt recording.
	6 Select Save in the File menu.

	Data Analysis
	Questions
	1 What effect does lying down have on the total amount of air breathed into the lungs/minute?
	2 What effect does lying down have on the various lung volume?
	3 Examining tidal volume, what is the effect of lying down?
	4 From your analysis of data on finger pulse, what is the effect of raising your hand on blood pr...
	5 With this answer in mind, in the standing individual would the blood pressure be the same in th...
	6 With this answer in mind, if you assume that the lower the blood pressure the more likely those...
	7 If some capillaries are collapsed, what would be the functional effect of this on the surface a...
	8 Now, in the individual who is lying down. Would you expect such a dramatic influence on the blo...
	9 If the blood pressure is about the same in all pulmonary capillaries would you expect the capil...
	10 If all pulmonary capillaries are open when lying down, what would be the functional effect of ...
	11 Considering the two body positions, if the demands for O2 and CO2 are the same, what should be...
	12 Can you predict any differences in the levels of O2 and CO2 in the exhaled air of people stand...
	Experiment 11: Factors that Effect Breathing Patterns
	Overview
	Equipment Required
	Equipment Setup
	1 Connect the ETH-256 unit to the A/D card (described in Chapter 1).
	2 Firmly push the two air flow tubes into the two outlets on the flow head.
	3 Firmly push the other ends of the two air flow tubes into the two outlets on the SP-100 spirome...
	4 Use the cable to connect the output on the spirometer unit to the input on channel two of the E...
	Figure 4-15 : Attach the spirometer and Plethysmograph to the ETH -256 unit.

	5 Set the controls on the ETH-256 as follows:

	Start the Software
	1 Click the (Windows) Start menu, move the cursor to Programs and then to the iWorx folder and se...
	2 When the program opens, select Load from the Settings menu.
	3 When the dialog box appears, select Human and then click OK.
	4 Click on the Settings menu again and select the Lung #3 settings file.
	5 After a short time, LabScribe will appear on the computer screen with the Lung #3 settings.

	Before Starting
	1 The spirometer will monitor breathing from a volunteer. It is important that the volunteer is h...
	2 The tubes on the flow head should always be in the upright position, to avoid problems with con...
	3 Turbulent air flow through the flow head will produce a noisy signal.To avoid turbulent air flo...
	4 The spirometer will display air flow on channel two. The software is set to integrate the data ...

	Exercise 1: Coughing.


	Procedure
	1 The volunteer should hold the spirometer head with the air flow tubes up. Breath normally—this ...
	2 Click Start and record the rhythmic signal produced by the volunteer’s breathing. Type “resting...
	3 After about five breathing cycles ask the volunteer to cough (type “cough” and press Enter on t...
	4 Click Stop to halt recording.
	5 Select Save As in the File menu, type a meaningful name and save the file in an appropriate pla...

	Data Analysis - Measurements
	1 Use the arrows at the bottom of the window to scroll to the beginning of the recording.
	2 Click the 2 cursor icon (Figure 4-16 on page 91), so that two blue vertical lines appear over t...
	3 Drag the cursors left and right to place them between the first two breathing cycles.
	4 Click the Analysis icon (Figure 4-16 on page 91) to open the Analysis window.
	Figure 4-16 : The LabScribe toolbar

	5 Click to de-select channels one and two.
	6 Click and drag the cursors left and right on channel three to place one on the trough of the si...
	7 Scroll through your record in the Analysis window and repeat the above measurement for all brea...
	8 Click the Journal icon (Figure 4-16 on page 91), label your data as a recording of tidal volume...
	Figure 4-17 : The spirometer signal (upper trace) and its integral (lower trace) recorded from a ...

	1 Use the arrows at the bottom of the window to scroll to the beginning of the recording.
	2 Click and drag the cursors left and right on channel three to place one on the baseline and the...
	3 Scroll through your record in the Analysis window and repeat the above measurement for all brea...
	4 Repeat with the air flow seen during the cough.
	5 Repeat these measurements for inhalation, using the downward deflections in channel three.
	Figure 4-18 : The integral of the spirometer signal recorded from a resting volunteer. The cursor...


	Questions
	1 What phase of the breathing cycle (exhale or inhale) immediately precedes the cough?
	2 Does the tidal volume change during the cough?
	3 If so, look at your data and determine if the tidal volume changed by changing the amount of ai...
	4 Compare the speed of air flow during a normal exhale and the cough. Which is faster?
	Exercise 2: Concentration

	Procedure
	1 Push the tip of a needle firmly into a piece of wax or an eraser. Place the needle close to the...
	2 The volunteer should hold the spirometer in one hand and a piece of thread in the other. As bef...
	3 Click Start and record the rhythmic signal produced by the volunteer’s breathing. Type “resting...
	4 After about five breathing cycles ask the volunteer to try to thread the needle—type “concentra...
	5 Click Stop to halt recording.
	6 Select Save in the File menu.

	Data Analysis
	Figure 4-19 : The integral of the spirometer signal recorded from a resting volunteer and display...

	Questions
	1 Which breathing parameters change during the time when fine motor control is required?
	2 Can you explain your observations?
	Exercise 3: Sitting Up

	Procedure
	1 The volunteer should lie down on their back and relax.
	2 As before, the volunteer should not be disturbed and should be relaxed and accustomed to breath...
	3 Click Start, type “lying down” and press Enter on the keyboard.
	4 Allow the volunteer to breathe about five complete cycles, type “sit up when inhaling” and pres...
	5 The volunteer should lie down on their back and relax. Repeat the above, but make the request t...
	6 Click Stop to halt recording.
	7 Select Save in the File menu.

	Data Analysis
	Exercise 4: Increasing the Length of the Airways

	Procedure
	1 The volunteer should sit in a chair. As before, the volunteer should not be disturbed and shoul...
	2 Click Start, type “resting” and press Enter on the keyboard. Allow the volunteer to breathe abo...
	3 Place a length of plastic tubing on the spirometer and record about 10 breathing cycles; type “...
	4 Click Stop to halt recording.
	5 Select Save in the File menu.

	Data Analysis
	Questions
	1 Do you think the oxygen requirements of the volunteer changed dramatically when the tube was at...
	2 Where does gaseous exchange take place in the lungs?
	3 Does gaseous exchange occur across the walls of the airways (trachea, bronchi and bronchioles)?
	4 If you increased the volume of the airways to match the resting tidal volume, would fresh air e...
	5 Why does the tidal volume increase when the volunteer breathes through a tube?
	Exercise 5: Breathing and Cardiac Function

	Equipment Setup
	1 Untangle the plethysmograph cable.
	2 Place the plethysmograph on the volar surface (where the fingerprints are located) of the dista...
	3 Push the DIN8 plug on the other end of the cable into the socket labeled channel one.

	Procedure
	1 The volunteer should sit quietly and, as before, should not be disturbed and should be relaxed ...
	2 Click Start and record breathing and the finger pulse.
	3 Click AutoScale in the channel one title area and see the rhythmic finger pulse signal get bigger.
	4 Type “deep breathing,” ask the volunteer to breathe slowly and deeply, and press Enter on the k...
	5 Click Stop to halt recording.
	6 Select Save in the File menu.

	Data Analysis
	Figure 4-20 : The integral of the spirometer signal (upper trace) and the finger pulse (lower tra...
	1 Look at your data. Does the heart rate (as shown by the finger pulse) appear to change during t...
	2 Quantify this by using the two cursors in the Analysis window to measure the time interval betw...

	Questions
	1 Where is the heart in relation to the lungs?
	2 If there is a negative pressure in the lungs, would the heart be subjected to the same pressure...
	3 Would a negative pressure outside the capillaries functionally increase the transmural pressure...
	4 Would this create an increase in the blood pressure in the veins of the thorax—i.e. those leadi...
	5 What would be the effect of a negative thoracic pressure on the rate of blood return to the heart?
	6 What would be the effect of negative pressure on the heart rate? Do you see this?
	7 Does gravity play a role in heart rate fluctuation during breathing?
	8 How would a decline in blood O2 levels (and/or an increase in blood CO2 levels) influence heart...
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